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ASTi Voisus Server Operator Manual (Ver. 1, Rev. L)
INTRODUCTION
ASTi’s Voisus provides superior networked voice and simulated comms capability in a ready-to-
deploy, easy-to-use, affordable product.

Voisus Capabilities:

• Links comms across Live, Virtual, Constructive, and Serious Game training domains

• Serves a wide variety of training applications: mission rehearsal, battle command/
operations center, procedures (ATC, UAS, JTAC), vehicle/aircraft operation, small unit 
tactics, maintenance

• Easily adapts to all training environments: simulator facilities, live ranges, austere locations, 
home station, classrooms

• Deployable from the box: Connect to network infrastructure, use web browser for rapid, 
low-overhead setup, and begin operation

Voisus is a family of networked modular products, designed for flexibility and scalability. Product 
modules include:

• Voisus Software Client - software app runs on computer desktops and mobile tablet 
devices. Provides access to voice comms across simulated radios, radio-over-IP, chat 
intercoms, VoIP calling and conferencing.

• Tactical Radio Simulator - software overlays provide realistic MIL radio simulation for 
PCs and mobile devices. Provides the training benefit of live MIL radios, but at a fraction of 
the cost. Radio Sim hardware versions are also available to meet requirements for high 
fidelity, realistic touch and feel.

• Radio Over IP - connect live radio to the network to realize: voice connectivity across live 
and virtual worlds, extend coverage between distant sites, conserve live radio assets as 
networked operators share common access to live radios, web-based radio remote-control 
(perfect for ranges).

• Serious Game Communications - embeds ASTi Radios into serious games like VBS2 to 
increase immersion and enhance training effectiveness.

• Simscribe - web-based networked capture and replay to enhance after action review (AAR) 
of voice comms. Integrates directly with VBS2.

The Voisus server is dedicated to heavy simulation processes and extends the powerful ASTi 
radio environment. It features a DIS interface and a network link to Voisus software and hardware 
clients. Users configure the Voisus server and clients with ASTi’s Remote Management System 
(RMS), which is accessed through a networked web browser.

Voisus Server’s network-centric architecture is highly scalable; simply connect more client 
positions to the IP network and centrally manage using RMS. Client-based operators can be 
located wherever there is access to the network.
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Figure 1: The Voisus Product Family
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SECTION 1.0. GETTING STARTED
The standard Voisus system includes the server platform and Voisus software. The server is 
available as a standard 2U, 1U, or small form factor. Voisus servers are shipped with Voisus 
software already installed. 

All operator headsets, USB adapters, radio panels, and PTT ancillaries are available separately. 
For a list of compatible USB adapters and headsets, see APPENDIX C: USB ADAPTERS AND 
HEADSETS.

This section includes:

• An overview of network configurations

• An overview of the ACENet Network (applies to Voisus products using additional audio I/O 
distribution hardware)

• Instructions to install the server and assign an IP address
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1.1. Network Configurations

Voisus Server utilizes three application network traffic links:

• RMS: Secure web server accessed by remote computers through a web browser. 

• DIS*: Inter-Server (or inter-simulator) communications

• Voisus: Server-client communications

*Distributed Interactive Simulation (DIS), IEEE-1278 standard

The illustration below shows the most basic network configuration for the Voisus Server system. 
All three application links share a common IP network. The benefit of this configuration is 
simplicity. 

Voisus Server

RMS

DIS

Analog Voice

Operator 1 & 2 Operator 3 & 4 Operator 5 & 6 Operator 7 & 8

DIS and
Voisus

Voisus 

USB Voice & PTT

Headset

USB Adapter
(PTT Optional)

ASTi Inter-Server
Communications 
via DIS

Eth0 Web-based 
communications,
configuration, 
and management

RMS

Common Network Configuration
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The illustration below shows a separate network configuration, with RMS and DIS application 
traffic on one IP network (DIS) and Voisus application traffic on another network (Voisus). The 
benefit of this configuration is network traffic management. Using this configuration, traffic 
segregation eases congestion on each network. Also, computers on each network are isolated 
from superfluous traffic (for example, Voisus Clients are not subjected to DIS traffic), which 
conserves processing resources. 

Voisus Server

Operator 1 & 2 Operator 3 & 4 Operator 5 & 6 Operator 7 & 8

DIS
Network

Eth0

ASTi Inter-Server
communications
via DIS

Voisus

Headset

USB Adapter
(PTT Optional)

Eth2

RMS
Web-based 
communications,
configuration, 
and management

DIS

Analog Voice

Voisus 

USB Voice & PTT

RMS

Separate Network Configuration
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1.2. ACENet Network

This section applies to Voisus products using additional audio I/O distribution hardware. 

The ACENet network provides a low latency, network-based audio and I/O distribution 
architecture. ACE-RIUs and ACU2s connect to the ACENet network via an Ethernet port on the 
back panel of the device using a Category 5 cable. The Category 5 cable connects to an ACENet 
approved Ethernet switch. The maximum cable length is 100 meters (328 feet). The Ethernet 
switch connects to the Voisus Server via a Category 5 cable. The maximum cable length is 100 
meters (328 feet). 

Note: ACENet devices do not support daisy chaining to additional units or internal switching 
across networks. 

Caution: Homemade cables are the number one reason for product performance 
problems. ASTi highly recommends using only manufactured, commercial, premium 
grade cable. 

ACENet Requirements 

In order to achieve a working ACENet infrastructure users must adhere to certain core 
requirements such as a closed network. No other traffic should be present on the ACENet 
network. Connect only Voisus Servers, ACE-RIUs, ACU2s, and ACENet compatible equipment 
to the network. 

All ACENet capable devices must adhere to the following cabling requirements: 

• CAT 5e cable or better 

• 100 meters (328 feet) maximum distance 

• Wire according to 1000 BASE-T Specifications 

Guidance for advanced ACENet configurations: 

Important: The Voisus Servers require that each individual system (comprised of a single server 
platform and a number of ACENet devices) be interconnected on its own ACENet. Conversely, 
you cannot connect multiple Voisus Servers and associated devices on a common ACENet.

• An Ethernet switch is required for ACENet (no routers or hubs). 

• Configure ACENet using multiple switches to realize flexible installations. Maximum of 6 
hops (5 switches) are accommodated. 

• Connect a maximum of 20 ACENet devices to a single Voisus Server.

• 1Gb operation is required for ACENet. 

• Only port-based VLANs are acceptable. 

• Each VLAN port must not see traffic from the other ports. 

• If using VLANS: place each Voisus Server and its associated devices on a separate VLAN. 

• VLAN tagging is not supported. 
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• Advanced protocols such as: 802.1p, port priority, spanning tree, etc. are not supported.

• The Voisus Server platform can connect directly to an ACENet device using crossover 
CAT5e cable. 

See the ACENet User Guide (DOC-02-ACENet-UG-1) for more information. See the ASTi web 
site for the most current versions of documentation (www.asti-usa.com/support).
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1.3. Server Installation

The Voisus Server and software are hosted on an off-the-shelf chassis. In addition to the server 
chassis, you will need the following items:

• Monitor

• Keyboard

• Power cord

• CAT5 or CAT6 cable

• Network connection

Ethernet Port Connections

Port Connection

Eth 0 DIS (Inter-server Comms)
Voisus (Server - Client Computer Comms)

Eth 1 ACENet audio distribution network

Eth 2 Voisus (Server - Client Computer Comms, 
Alternate Configuration)

Network Ports

See chassis labels for ethernet assignment.
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Follow these steps to install the server and assign an IP address.

1. Connect the server to a monitor and keyboard. Note that a monitor and keyboard are only 
necessary for initial software configuration.

2. Connect the server’s Ethernet interface(s) to the DIS network (linking to other servers). 
See section 1.1. Network Configurations for guidance.

3. Connect to power.

4. Log in with the following:

Username: root 

Password: abcd1234

Each Voisus server also comes configured with an administration account that may be 
used for non-root configuration:

Username: astiadmin 

Password: admin

It is important to not delete or rename the administration account, as the Voisus software 
utilized this account for proper functionality.

5. The server will not have an IP address without a DHCP network connection. To set an IP 
address, type:

ace-net-config -a xxx.xxx.xxx.xxx -n yyy.yyy.yyy.yyy

where ‘xxx.xxx.xxx.xxx’ is the IP address and ‘yyy.yyy.yyy.yyy’ is the subnet mask. 

This sets the IP address and netmask for Eth0 which is used to access the Remote Man-
agement System (RMS) via a web browser.

6. Optional: For more network setup options type: 

ace-net-config -h

7. To activate the changes reboot the server by typing: 

reboot

8. Once you have configured Eth0, you can use RMS to make additional changes to the net-
work settings. 
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SECTION 2.0. REMOTE MANAGEMENT SYSTEM
RMS provides centralized, network-based tools that are used to configure and manage server 
systems. RMS is compatible with the following web browsers. Other browsers may function in 
limited or unexpected ways and are not supported by ASTi. 

Browser Version

Google Chrome 9 - 24

Safari 5 - 6.2

Firefox 3.6 - 14

Internet Explorer 8 and 9

All software is pre-installed during factory system integration. Should you need to re-install the 
system software, please refer to the corresponding Cold Start Procedure. 

2.1. Access RMS

1. Start a web browser on the same network as the server. 

2. In the address field, type the server’s Eth 0 IP address and press enter.

http://xxx.xxx.xxx.xxx/

3. After pointing the browser to the server, RMS will respond by displaying the main login 
page.
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4. Log in with:

Username: admin 

Password: astirules

Note: Do not delete the default user name.
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5. Select the ‘Voisus’ application icon. 

6. The Voisus Server dashboard appears. 
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2.2. Management

RMS provides several management tools:

• Network Setup

• Licensing & Credits

• System Backups

• Remote Radio Control

• DIS Settings

• User Management

• Documents and Info

• S.O.S. Reports

• System Identifier

• About the System

• Install ACENet Firmware

These tools can be accessed from the dashboard as well as the “Manage...” drop-down menu 
within RMS.
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2.2.1. Network Setup

The first step toward successful setup and integration of a system is coordination between all 
Voisus Server sites to ensure that critical communications parameters are defined. Follow the 
steps in this section to ensure proper configuration. 

On the Voisus dashboard, click the Network Setup icon.

2.2.1.1. Network Settings
Click the Settings tab.

Hostname

(Required) Give the server a name to help identify it on the network. 

Domain

Provide the domain name for the server. This is also used to perform name look-ups for other 
servers on the network.

Gateway IP

This is the IPv4 address of another server that routes traffic for the network. This setting over-
rides the Default Interface setting below.

Nameservers

A list of servers on the network to ask when attempting to match hostnames to IP addresses. 

NTP Servers

A list of servers on the network from which to synchronize the system clock. 
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Device

For initial configuration Voisus Server uses Eth 0. Other interfaces may be used if necessary.

Mode

Off: disables the ethernet interface.

Fixed: you must also provide an IP address (IPv4) and a subnet mask for the interface.

DHCP: the IP address and subnet mask are automatically assigned.

IPv6 Only: will bring up the interface, but will not assign or request IPv4 address/mask infor-
mation.

Be sure to save changes when you are done.

2.2.1.2. Network Status
The network status tab displays the settings that are currently in use by the system. Select each 
ethernet port to view the settings and status. 
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2.2.2. Licensing & Credits

Each operator (hardware or software) consumes 800 credits each, regardless of how many radios 
are used. If you reach your credit limit, you will not be able to add additional operators but your 
existing operators will continue to function.

Activating the Radio Bridge capability incurs a 2000 credit cost in addition to 800 credits for the 
first radio bridged. Each radio bridge after that consumes 800 credits.

Contact ASTi to add credits to the system if you need additional functionality.
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2.2.2.1. Uploading Tokens
To add or change the functionality of the Voisus Server the system license must be updated. To 
update the system license a new token must be uploaded. Please contact ASTi about acquiring 
additional system functionality.

To upload a token to the Voisus Server:

1. On the Voisus dashboard, click the Licensing & Credits icon. Alternatively, view the 
system licensing information by navigating to Manage... > Licensing. The credit amount 
is displayed.

2. Select the ‘Tokens’ tab.

3. Open the new token file in a text editor (e.g. WordPad, TextEdit, etc.) and copy all of the 
text in that file.

4. Paste the text from step 5 into the text entry box under the ‘Add Token’ and select the 
‘Add Token’ button.
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2.2.3. Back Up and Restore the System

Voisus Server’s Backup tab utility provides a means to completely backup and restore your 
system for disaster recovery or software upgrade. The backup process includes all of the files 
necessary to completely restore your system to its previous state. This includes your Comm Plans, 
Facilities, Scenarios, RMS users, last installed Scenario, and DIS Settings. Backup and restore is a 
complete restoration except for user names and passwords. 

Note: Before performing a system cold start, the system should be backed up.

Create a Backup

1. On the Voisus dashboard, click the System Backups icon. Alternatively, navigate to 
Manage... > Backups.

2. Click ‘New...’ to create a backup file. 

3. The ‘Create a New Backup’ window will open. Enter a meaningful filename and do not 
check the ‘Text Only’ box. Click ‘Create’.

4. Upon completion, a ‘Success’ notification will appear.

Note: This only creates a local copy on the Voisus server.

5. Select the disk icon to save the backup to the local RMS computer 
that you are currently using. The file is saved to the default 
download directory

At this point you are ready to perform the system cold start. This will erase 
the system’s hard drive. Please refer to the Voisus Server Cold Start 
Procedure (DOC-05-VS-CS-1). 
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Restore a Backup

1. In RMS, navigate to System Backups.

2. If the Voisus Server was cold started, there will be no backup files stored on it. The file 
must be uploaded to the system. Click ‘Import’ to import a previously backed up file. 

3. Click ‘Choose File’ to open the file browser window.

4. Search for and select the previously backed up file.

5. Click ‘Submit’ to import the file to the Voisus Server. The imported file details will now 
be displayed in the file list.

6. Click the wrench icon under ‘Actions’ to restore system files.

7. Click the “Restore” button.

8. After the files have been restored, you will be prompted to reboot the Voisus Server. Click 
the “Reboot” button and wait for the Voisus server to reboot. This may take a few minutes.

2.2.4. Remote Radio Control

Remote Radio Control is covered in detail in section 7.2. Remote Radio Control.
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2.2.5. DIS Settings

Click the DIS Settings icon on the Voisus Dashboard or click the DIS tab within RMS to view the 
DIS networking and configuration. Follow the steps below for custom DIS configuration. Contact 
your exercise administrator to determine the proper DIS configuration parameters. 

1. Select the network mode. 

2. Select the IP mode. 

3. Select an Ethernet Interface. Eth0 is the default.

4. Fill in the UDP Port number. The default port number is 3000.

Note: All of the communication systems on the DIS network must share a common DIS 
UDP port number.

5. Select the DIS version number: 4, 5, 6 or 7.
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6. Enter the Exercise ID (1-255). Note that radios and sites can only inter-communicate if 
they share the same DIS Exercise ID.

7. Select the Site and App ID mode. Each server on the network must have a unique set of 
DIS IDs.

8. Optional: Set the radio timeout settings. Radio timeout and threshold ranges:

Normal Timeout: 1- 65,535 seconds

Moving Timeout: 1-65,535 seconds

Moving Threshold: 1-999,999 meters

9. Optional: Select “Multicast by Exercise” to use multiple multicast addresses. A base 
multicast address will add the Exercise ID to the last octet, provided it is within the 
exercise range set on this page.

Click “Apply and Save”.

2.2.5.1. DIS Network Modulation
In this section we will describe how to use the Waveform Mapping File to Set DIS Transmitter 
PDU Enumerations in Voisus.

Background – DIS Transmitter PDUs and Modulation Type

In accordance with the IEEE 1278.1 Standard for Distributed Interactive Simulation (DIS), 
Transmitter PDUs incorporate a Modulation Type Record that defines the modulation type of the 
transmitting simulated radio. The modulation type is one of the key characteristics (along with 
tuned frequency and the like), which determines whether radios can inter-communicate.

The Modulation Type Record characterizes radio modulation through four enumeration fields:

• Spread spectrum

• Major modulation type

• Detail

• System

You can find more information about the DIS transmitter PDU and the Modulation Type on the 
SISO web page: http://www.sisostds.org

Waveform Mapping – Convert Radio Operating Modes into DIS PDU Enumerations

Voisus Server supports a wide range of modulation types such as: AM, FM, Single Sideband and 
Intercom (literally, no modulation). Voisus Server also features SINCGARS and HAVEQUICK 
transmission security system simulation and simulation of various SATCOM systems. All of these 
characteristics are incorporated into an operating definition called a Waveform.

Waveforms are internal system records that, among other things, contain a Mode field. A mode 
identifies a fundamental tuning method within the ASTi radio system. Each tuning method is 
embedded inside the software. Therefore you can think of the mode field as containing the name 
of the tuner that server uses to process a given waveform.
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The server includes DIS Gateway software that converts (or maps) internal waveform settings to 
DIS modulation parameters. Each ASTi Radio waveform has a default DIS Modulation Type 
enumeration. 

For example:

ASTi Radio 
Waveform

DIS: Spread 
Spectrum

DIS: Major 
Modulation 

Type
DIS: Detail DIS: System

FM 0 3 1 1

Waveform mapping occurs when the DIS Gateway encodes a DIS Transmitter PDU during 
transmission or decodes a Transmitter PDU during reception.

In specific cases, users may need to change the default DIS Modulation enumerations for a 
Waveform. The Voisus Server provides the capability to customize DIS modulation parameters 
(system, spread spectrum, major and detail) for each type waveform. 

Each radio on the DIS network is defined with a waveform modulation, for example 1.2.1.0, 
where 1.2.1.0 is major.detail.system.spread spectrum. The Voisus Server decodes the waveform 
modulation numbers 1.2.1.0 as an AM radio. Let’s say there is a 3.1.1.0 radio on the DIS network, 
the Voisus Server will know this means FM radio based on the waveform numbers. 

DIS radios may have other waveform modulation values that are not standard values and 
therefore they are not recognized by the Voisus Server. In the example shown above, we want 
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4.3.2.1 to be recognized by the Voisus Server as an FM radio. To do this you will have to add a 
waveform modulation defined with 4.3.2.1. 

The remainder of this section describes the procedure for customizing the mapping of waveform-
to-DIS enumerations using the Voisus Server Remote Management System.
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How to Customize the Waveform Mapping Definitions

Add a Modulation

In RMS navigate to the DIS page. At the bottom of the page select “DIS Network 
Modulations…”. 

On the DIS Network Modulations page you can create a network modulation record which is used 
with a commplan defined waveform to override the standard default values. A Network 
Modulation record is used when its identifier values match that of a waveform's network 
modulation key. 
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Add the waveform ‘Network Modulation Key’ in the Comm Plan. 

For example, if your commplan contains a waveform named “ModulationVHFAM”, and a new 
set of DIS enumerations were required one could set the Network Modulation Key column value 
to “ModulationVHFAM”. Then on the DIS Network Modulation page add a new modulation and 
set its identifier to “ModulationVHFAM.” If the names match, the values of the modulation 
record will be used.

This two-way mapping specifies that any local radios that are configured to use the waveform 
“VHF- AM” in their commplan will generate transmitter and receiver PDUs with the above 
specified DIS modulation parameters. It also says that any remote radios that contain exactly that 
combination of parameters will be given the mode specified in the waveform VHF-AM (this will 
usually be AM).

Wildcards

You can also leave off attributes and the DIS gateway will create a wildcard for the corresponding 
attribute in the PDU-to-Waveform mapping. For example:

waveform VHF-AM default

system=1 

spreadspectrum=0 

major=1 
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The detail field is missing; therefore any PDU that matches this last mapping but does not match a 
more specific mapping will use this wildcard mapping for the conversion to Waveform.

If a field is not specified then a value of 0 is used. In the example above, there is not a detail field 
specified so a value of 0 will be used. 

Specifying PDU-to-Waveform and Waveform-to-PDU Wildcards

Specify a wildcard for the PDU-to-Waveform mapping while also specifying a particular value to 
use on the Waveform-to-PDU mapping. For example:

waveform VHF-AM

system=1 

spreadspectrum=0 

major=1 

detail= -2 

The negative number used for the detail attribute says that when creating a PDU, set the detail 
field to 2. However, when mapping from a PDU to a Waveform, the detail field is a wildcard and 
does not require the value to be 2. This one mapping then does the job of both "waveform VHF-
AM" and "waveform VHF-AM default" shown in the examples above.
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Default Values

The DIS gateway default Waveform-to-Modulation mappings:

Decision Tree

For PDU-to-Waveform mappings, the DIS gateway builds a decision tree that is used to convert 
system, spread spectrum, major and detail (in that order) into a mode. 
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2.2.6. User Management

Click the User Management icon on Voisus Dashboard or navigate to Manage > Users. This tool 
enables you to define additional user names or change the password of an existing user.

Note: Do not delete the default “admin” username. This account is required for proper RMS 
functionality. The password may be changed to meet facility security requirements. 

To add a user, simply select the ‘+’ button and add the username and password. Then click the 
‘Add’ button. 

2.2.7. Documents and Info

The Documents and Info tool gives you access to web-based and PDF versions of Voisus 
documentation.

Access it by clicking the Documents and Info icon on the Voisus dashboard or navigate to 
Manage... > Documents and Info within RMS.
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2.2.8. SOS Reports

The SOS Report generates information for situations that require ASTi troubleshooting. Click the 
S.O.S. Reports icon on the Voisus Dashboard or navigate to Manage... > SOS Report. Click 
“Generate SOS Report”. This creates a report with useful information for ASTi debugging. Save 
the file to the local computer. 
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2.2.9. System Identifier

To update the system’s identification, click the System Identifier icon on the Voisus dashboard or 
navigate to Manage > System ID within RMS. Enter the contact information and installation 
details.

2.2.10. About the System

To view the Voisus Server software details, click the About the System icon on the Voisus 
dashboard or navigate to Manage > About from within RMS. 
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2.2.11. Install ACENet Firmware

In RMS, navigate to Manage > Firmware. The Firmware page displays the ACENet devices 
currently connected over the network to the Voisus Server. The devices will only be displayed if 
they are in boot mode. Select the ‘How do you put a device in boot mode?” link to view the 
instructions.

The firmware version displayed is the recommended firmware version for the software running 
on the server.

Select the “Install Firmware” button. Wait as the firmware installs. 
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Once the firmware installation is complete, the devices must be returned to normal operation 
mode. 
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2.3. Monitoring

RMS provides several monitoring tools:

• Monitor Radios

• Monitor Active Clients

• Performance Monitor

• Discovery

• ACENet

• Hardware Panels

• Runtime Status

These tools can be accessed from the dashboard as well as the “Monitor...” drop-down menu 
within RMS.
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2.3.1. Monitor Radios

The Radio Monitor provides the ability to view the radios on the network and view which radios 
are in-tune with each other. The Radio Monitor only displays radios matching the current DIS and 
network settings. This tool provides the Voisus Clients with an accurate view of available radios 
to communicate with.

Each radio has a unique name. Radios that are controlled by Voisus Clients will appear as 
“clientname_radioX” where clientname is the client’s configured username. Radios that are 
coming from remote DIS communication systems are named based on their unique DIS radio ID. 

Radios actively transmitting are illuminated.

There are many ways to view and sort the radios.

View by Radio Type

The radios can be filtered by type such as VHF, UHF, etc. 

Sort by Radio Parameters

Radios can be sorted by name, source, frequency, etc. For example, to sort radios by fre-
quency simply select the frequency tab. To sort radios by frequency and then by source, sim-
ply select the frequency tab and then press and hold shift while selecting the source tab. 

View Differences

To compare the differences between two or more radios, check the radio boxes and select the 
“Diff” button. Radios with no differences are in-tune and will be able to intercommunicate. 

View Single Detailed Radio

Double-click on a radio to open the detailed view for a specific radio. This allows you to view 
the entire DIS Transmitter PDU as well as the audio encoding information. This is the same 
view as the Diff view, but only displays one radio.
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View By Frequency

The radio monitor allows the selection of a specific band of radio frequencies. Click and drag 
the mouse over the selection of the radio band you wish to view. Then click on the pink band 
and the list will only show radios in that frequency band.

2.3.1.1. Radio Statistics
The Statistics tab displays radio network information including DIS and Ethernet settings.
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2.3.2. Monitor Active Clients

To view the clients connected to the Voisus Server over the network, click the Active Clients icon 
on the Voisus dashboard or navigate to Monitor > Clients within RMS. Active clients are 
highlighted in pink and idle clients are highlighted in blue.

2.3.3. Performance Monitor

The Performance Monitor displays debugging and troubleshooting information. 
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2.3.4. Discovery

The Discovery tool displays all Voisus servers on the network and their attached ACENet devices. 

Access this tool by clicking the Discovery icon on the Voisus dashboard or by navigating to 
Monitor... > Discovery within RMS.

2.3.5. ACENet

This page displays ACENet devices currently in use in the installed Scenario. Access this tool by 
clicking the ACENet icon on the Voisus dashboard or navigating to Monitor... > ACENet.

See all ACENet devices available on the network in Discovery (via the Discovery icon or 
Monitor... > Discovery).

2.3.6. Hardware Panels

This tool allows you to view and manage your ASTi hardware panels including the PRC-117 
panel over the network. You can set panel-specific configurations such as name, MAC address, 
Broadcast Port, Host Address, Status, and Firmware.

Access this tool by clicking the Hardware Panels icon on the Voisus dashboard or navigating to 
Monitor... > HW Panels.

2.3.7. Runtime Status

View the status of all the hardware and software clients connected to your Voisus server.

Access this tool by clicking Runtime Status on the Voisus dashboard or by navigating to 
Monitor... > Status.
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2.4. Configure Communications in RMS

Establish communications for your software and hardware clients by configuring Comm Plans & 
Roles, Facilities, and Scenarios.

Comm Plans & Roles

The Comm Plan consists of communication nets, which are sets of operational parameters 
such as frequency and modulation type. Roles are collections of radios and their nets, to be 
used by Voisus hardware and software clients over the network.

Facilities

The Facility defines all of the ASTi communications hardware in your training installation. 
This includes servers, ACENet devices, HHTs, radio panels, and live radio interfaces. If you 
are only using Voisus Software Clients, you do not need to configure the Facility. Continue on 
to Scenarios.

Scenarios

The Scenario is the overall exercise definition that links the Comm Plan & Roles software 
configuration with the Facility hardware configuration.

2.4.1. Comm Plans & Roles

The Comm Plan and Roles tools generate the communications configurations that are distributed 
to clients. Every Voisus Server comes pre-configured with a complete comm plan. Continue with 
this section to configure your system to your specific requirements or skip ahead to the next 
section.

• Use the Comm Plan tool to generate a list of communications nets.

What is a net? A net is a set of operational parameters (like tuned frequency and modula-
tion type) that can be assigned to a simulated radio. Radios must share key net settings 
(like frequency and modulation type, and optionally crypto and frequency hop fills) to 
intercommunicate.

• Use the Roles tool to create operator communication configurations for use by clients.

What is a role? A role is a predefined communication configuration that can be assigned 
to one or more clients. The role incorporates a set of one or more radios that are accessible 
by the client. As part of the role building process, each radio may be loaded with one or 
more nets. A radio loaded with one net is fixed (non-tunable). A radio loaded with multi-
ple nets can be tuned by the client operator.
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• Once created, roles are available for use by Voisus Clients or hardware operators.

• From a Voisus Client, connect to the server and select a role. The client will automatically 
be configured with access to the set of radios defined by the role.

• Additional changes to the role will automatically update all connected clients.

2.4.1.1. Comm Plan 
Use the Comm Plan tool to build a list of radio nets that will be used in the Roles section to load 
radios with presets. Radio nets require a name, frequency and waveform. For ease of use, you 
may also use the arrow-keys on your keyboard to navigate through the nets. Press ‘enter’ to edit a 
field. All comm plan changes take effect immediately and do not require a Scenario reinstall.

Note: Changes to existing nets are reflected in the radio’s real-time operation. There is no need to 
re-install the Scenario after altering the frequencies, FH Net IDs or Crypto Keys. However, major 
changes to the comm plan such as creating individual fills for each radio will require a re-
installation of the Scenario for the changes to take effect.

Follow these steps to create a net:

1. Select the Comm Plan tab.

2. Select “Add Net”.

3. Double-click the “Name” field and enter a name.

4. Optional: Double-click the “Description” field and enter a description.

5. Double-click on “Frequency” and enter a tuned frequency (in hertz).

6. Double-click on “Waveform” and select a modulation type (defaults are AM, FM, 
intercom, SINCGARS, and Havequick).

Optional: Configure COMSEC, TRANSEC and SATCOM parameters:

7. Double-click on “Crypto” and select a crypto configuration.

8. Double-click on “Freqhop” and select a frequency hop configuration.

9. Double-click on “Satcom” and select a satcom configuration. Note: Satcom requires a 
separate satellite server. Contact ASTi for more details. 

To manage or build additional net elements (waveforms, receiver gains, crypto, frequency hop 
and satcom), use the associated check-boxes to access submenus. Then select the “Add” button 
and enter the associated parameters.

You may also organize nets into groups. Groups provide an efficient one-step method of 
preloading radios in the Roles. To create a group:

1. Select “Add Group”.

2. Enter the new group’s name.

3. Then select “Add Net” from the net list pull-down and select nets to add to the group.
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Additional Net List Organization

Nets can be sorted by name, frequency, transmit frequency, waveform, etc. For example, to sort 
the list of nets by frequency, select the “Frequency Hz” column name. You can also search for a 
specific net using the search bar.

Alternatively, you can create a group and select multiple nets (press control-click or shift-click), 
by right-clicking and copying the nets. Then right-click the group name and paste the nets. This 
copy and paste method also applies to waveform, crypto, frequencies, and SATCOM. 

For further understanding, follow the example below. 

1. Create nets as needed.

2. Create a group called “Squad”. 

3. Select the nets (press control-click or shift-click) that you want in the “Squad” group. In 
this example, the Conference 1-3 nets are selected.
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4. Right-click and copy the nets.

5. Right-click on the Squad group name and select “Paste Nets”.

6. Now the Conference 1-3 nets will appear in the Squad group.
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Comm Plan Import/Export

Use the Comm Plan Import and Export features to share your comm plans among locations. 

1. With the comm plan open, select “Export” from the drop-down menu to convert the comm 
plan to CSV (Excel) format and save to your PC. (Note: If desired, you can make changes 
to your comm plan in Excel.) 

2. Using email or another file transfer method of your choice, send the CSV file to other 
Voisus Server users.

3. Select “Import” and select the desired CSV file from your PC’s hard drive to convert to a 
comm plan.

Note: The Comm Plan Import/Export feature only applies to Comm Plan specific items (Nets, 
Groups, Waveforms, ReceiverGains, FreqHop, Satcom). It does not import or export Role 
information.
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2.4.1.2. Roles
Use the Roles tool to create radio communication pre-configurations (or roles) which are used by 
clients. There are two types of roles:

Personal Role

A client that assumes a personal role is assigned a set of one or more radios that are con-
trolled and accessed only by that client. An example application of a personal role is a cli-
ent operating as a dismounted soldier accessing a personal squad radio. Note that any 
number of clients can assume a common personal role. In this case, these clients will have 
identical radio configurations, but will have sole possession (access and control) of their 
own radios.

Vehicle Role

A client that assumes a vehicle role is assigned to a set of one or more radios, and these 
radios are collectively accessed and controlled by all clients using the vehicle role 
instance. An example application of a vehicle role is a group of three clients operating as 
vehicle crew. In this case, the three clients will assume the same vehicle role instance and 
have control and access to a bank of common radios.

Creating Roles

Follow these steps to create a personal role:

1. Select the Roles tab. 

2. Click “Add Personal Role”.

3. Fill in the name.

Note the numbered columns (1, 2, 3, etc.) in the role table. Each column represents a 
radio. The next step is to preload the radios with nets.

4. From the “Nets” list, copy nets into a radio using the right-click menu. You can also copy 
and paste net groups into a radio (loading a set of multiple nets in one step).

5. Continue by preloading additional radios with nets.

Note: The order of nets loaded in a radio determines the order in which they are displayed 
in the client. You can re-order nets by dragging and dropping.
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To create a vehicle role select “Add Vehicle Role” and then follow the steps 2 through 4 above.

Asset Configuration

Select a role and click “Show Asset Config.” This allows the administrator to set the Radio Type, 
transmit and receive settings, and Default Net for each asset. This data is automatically populated 
into the client setup upon connection to the server.

The Radio Type drop-down provides the option to assign a Generic or PRC-117F control head to 
the asset. The Generic or PRC-117F faceplate is used by the Tablet Voisus App. See section 3.5. 
Tablet Voisus App for more information. The Radio Type setting will be ignored by all other 
Voisus software clients for Windows, Linux, and VBS2. 
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2.4.2. Facilities

The Facility defines all the ASTi communications hardware in your training installation. This 
includes servers, ACENet devices, HHTs, radio panels, and live radio interfaces. If you are only 
using Voisus Software Clients, you do not need to configure the Facility. Continue on to section 
2.4.3. Scenarios.

Each position in the Facility represents the hardware available to a single operator. For example, 
if an operator is supposed to have a PRC-117 radio panel as well as an observer speaker, you 
would configure a position with a PRC-117 panel and an observer mic/speaker. Once you have 
configured all of the hardware positions, you will map communication roles (radios and 
intercoms) to them in the Scenario (see section 2.4.3. Scenarios).

1. On the Voisus Server screen, select the “Facility” tab.

2. Select a default facility or add a new one.

3. Under the ‘Comms Hardware & Peripherals’ tab enter the number of hardware positions. 
A position represents the physical hardware assigned to a specific location such as a desk 
for operator 1.

4. Double-click the positions to name them for your specific setup.

5. Add the hardware positions.

Options include:

• HHT with headset

• SINCGARS Panel

• PRC-117 Panel

• Observer Mic/Speaker*

6. Edit the hardware position(s) by adding the hardware details including: asset, ACENet 
device, audio channel, serial port and monitor. Note that the asset number corresponds to 
the role asset setup in the comm plan.

7. Optional: Add software clients if you wish to lock down the client or assign the role and 
DIS exercise. The software clients configuration is completed in the scenario.

8. Under the ‘Live Radios’ tab add live radio interfaces if your system is being used for live 
radio bridging. Each interface connects one live radio to the DIS network. 

9. Under the ‘Servers’ tab add additional servers if using the master/slave configuration. See 
section 2.5. Multi-Server Configuration for details. 

10. Click “Save Changes” when finished.

* Each observer may only be associated with a single hardware item (PRC-117, SINCGARS, 
etc.), however multiple observers can be connected to the same hardware device in a position. 
 The observer will mirror the hardware device, receiving the same audio and being able to 
transmit on the device as well.
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For example, if you want to configure a speaker to play the same audio received on a PRC-117, 
you would add an observer to that position, select the PRC-117 panel that you want to monitor, 
and select an ACENet Device/Channel to output the audio to.
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2.4.3. Scenarios

The Scenario is the overall exercise definition linking the Comm Plan & Roles software 
configuration to the Facility hardware configuration. If your installation does not use any 
hardware operators, then you do not need to add any Facility operators to your scenario. Simply 
select the Comm Plan and install it. Any changes to the comm plan will immediately take effect 
for software clients.

In the Scenario, the operators are created and assigned to a communication role and a hardware 
position. Each role is mapped to the hardware items in the positions. For example, if you have two 
nets in asset #1 of a role, those two nets will be assigned to the first hardware item in the selected 
position (a PRC-117 for example).

If the role has more assets defined than hardware devices in a position, then those assets are not 
used. However, if a position has more devices (observers excluded) than assets in a role, those 
devices will NOT be able to communicate.

Follow the steps below to define the Scenario:

1. Select a Scenario, Comm Plan, and Facility for your system.

2. In the Hardware Operators tab, add the operators. An operator is assigned a name, role, 
position and DIS exercise ID. The role assets are mapped to the hardware for the selected 
position. For example, Admin1 is assigned the Admin assets as defined in the Role 
Builder with position Desk 1 as defined in the Facility. Sites can only communicate if they 
share the same DIS exercise ID.

3. Optional: The software clients tab provides a way to lock software clients and define roles 
and exercises.
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4. Optional: Vehicles are associated with the vehicles roles set up in the Role Builder. 
Vehicles are used for shared communication platforms.

5. Optional: If you are doing live radio bridging, add live radio interfaces. The interfaces 
must first be defined in the Facility.

6. Save and install the scenario. This assigns the nets to the radios.

Note: The last installed Scenario is the one that is installed upon system boot-up.
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2.5. Multi-Server Configuration

The Voisus Server multi-server feature is used to simplify configuration for programs with large 
numbers of operators and servers. Multiple servers are organized in a master-slave relationship, 
allowing the master server configuration to be automatically shared with all the slaves. Shared 
configuration includes comm plan, roles, DIS settings, scenario, and facility. 

To set up a multi-server configuration follow the steps below. 

1. Using RMS on the master server, set the desired settings for the DIS network, comm plan, 
role, scenario and facility.

2. In the facility, add the hostnames or IP addresses of each server (including both master and 
slaves). Remember the master is the server that is being configured.

3. In the scenario, select the facility that was just configured. 

4. Select “Install Scenario” to push the configuration to all the servers and run the scenario.

The boot order of the master and slaves is important. Reboot the slaves and then reboot the master 
last. The slaves must be on and running when the master installs the scenario so the changes are 
pushed to all the slaves. If a slave is not powered on the scenario installation may fail. If a slave is 
rebooted, a reinstall is needed to push the changes to the slave. 

Important: Multi-server control is enabled by default on standard Voisus platforms. If the IA 
Maintenance software package is installed, the multi-server control interface is disabled by 
default and must be enabled to function. See APPENDIX D: INFORMATION ASSURANCE 
FEATURE CONTROL for additional information.
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2.5.1. Multi-Server Example 

This example connects three servers with one master and two slaves.

• Server 1 with 24 Clients (master)

• Server 2 with 8 radio panels (slave)

• Server 3 with 16 hand-held terminals (HHT) (slave)

Connect these three servers in a multi-server configuration by adding the server hostnames or IP 
addresses to the “Servers” section in the facility of the master server. All comm plan, role, 
scenario, facility, and DIS configurations must be on the master server. When the scenario is 
installed, the configuration is sent from the master to the slaves resulting in all the systems being 
in sync. In this example, the HHT operators, radio panels and Clients will all share the same nets 
and roles.

Important: The Voisus Servers require that each individual system (comprised of a single server 
platform and a number of ACENet devices) be interconnected on its own ACENet. Conversely, 
you cannot connect multiple Voisus Servers and associated devices on a common ACENet.

Network

Master

8 Radio Panels 24 Clients 16 Hand-Held Terminals

Slave Slave

Perform server 
configuration
on master server

Install scenario to 
send configuration 
to slaves

1

2

Server 1 Server 2 Server 3
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SECTION 3.0. VOISUS SOFTWARE CLIENT
3.1. Voisus Client Overview

Voisus software clients are communication software-based operator GUI panels with remote IP 
audio. Simply download the client application using the Remote Management System (RMS) web 
interface, remotely configure, and operate. 

Voisus Client:

• Runs on RedHat® Enterprise Linux® or Windows® workstations and Windows® tablets

• Includes a GUI comm panel providing access to multiple ASTi radios and intercoms

• Is remotely configured and managed using RMS

• Controls up to 16 radios per operator (8 personal radios and 8 vehicle radios) 

• Supports a variety of headsets and PTTs

• Provides a built-in test for headset, hardware PTTs and microphone

Voisus Clients for Windows:

• Desktop Client: for use on desktop PCs.

• Tablet FullScreen Client: similar to the Desktop Client, but optimized for touch devices 
with smaller screens.

• Tablet Voisus App: provides a PRC-117F faceplate and the option to remotely control live 
radios.

• Tablet TOCNET CAU Client: simulates the interface of the Tactical Operation Center 
InterCommunication System (TOCNET) desktop Crew Access Unit (CAU). It is optimized 
for use on a tablet computer.

Voisus Client for Linux:

• Desktop Client: for use on desktop Linux computers.
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3.1.1. Client System Requirements

The Voisus software runs on a computer with an Ethernet network connection. See the table 
below for supported operating systems.

Operating System Requirements

RedHat® Enterprise Linux®

5.4+ (32 bit)

GTK, ALSA, libusb and libprotobuf

CentOS 5

Windows® XP (32 bit) Service Pack 2 or 3 

Windows® Vista (32 and 64 bit) Service Pack 1

Windows® 7 (32 and 64 bit) n/a

The minimum system requirements include:

• Intel Pentium 4 1.3 GHz or better

• 1 GB RAM

• 10/100 Ethernet card 

• USB 2.0 port (available for connection to USB adapters and headsets)

• monitor (recommended minimum resolution of 1280 x 800)

• mouse

• keyboard

• Voisus Server on the network
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3.1.2. Choosing an Audio Device on the Client

On the client PC you must select the audio device that Voisus will use. This will vary depending 
on the operating system. Plantronics devices will show up as “DA40 Adapter” and the radius 
device as “ASTi Radius”. 

3.1.2.1. Linux Default Audio Device

If you are using a Linux OS, navigate to System > Administration > Sound Card Detection and 
ensure that the proper audio device is selected as the “Default audio card.” 
Copyright © 2013 Advanced Simulation Technology inc. 55



ASTi Voisus Server Operator Manual (Ver. 1, Rev. L)
3.1.2.2. Windows Default Audio Device 

If you are using a Windows OS, navigate to the Control Panel > Sounds and Audio Devices and 
ensure that the proper audio device is selected as the default Sound Playback and the default 
Sound Recording device.
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3.2. Client Software Installation

Follow the instructions below to download and install the Voisus Client. 

3.2.1. Download the Client

Download the Voisus Client software using RMS. 

1. Navigate to RMS using a standard web browser on any computer with the same network 
(LAN/WAN) as the Voisus Server. Open the web browser and in the address field enter:

http://xxx.xxx.xxx.xxx/

where “xxx.xxx.xxx.xxx” is the IP address assigned to the server’s Eth 0 interface.

2. Log in:

Default Username:admin

Password: astirules 
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3. Click the Voisus icon.

4. Click the “Download Voisus” icon. 
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5. Download the installer that corresponds to your operating system. See section 3.1.1. 
Client System Requirements for more information. 

6. Move the install file to the client system. 

7. Continue with the following section that corresponds to your operating system (Windows 
or Linux). 
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3.2.2. Windows Installation

First download the Voisus Client (.exe) file for Windows from RMS as described in section 3.2.1. 
Download the Client.

To install:

1. Double-click the EXE file. 

2. Click Run in the Open File dialog. 

3. In the Setup dialog, click Next to continue.

Note: You may get a security alert as shown below. Select to allow Voisus communica-
tions on private networks or check with your network administrator. 

4. Select the destination location for the file and click Install.

5. When the installation is complete, click Finish. 

6. Open Voisus Client by selecting Start > All Programs > ASTi > Voisus Station.exe. 
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3.2.3. Linux Installation

This section describes how to install the self-extracting Linux Voisus Client file. First download 
the Voisus Client file for Linux from RMS as described in the previous section.

1. Open a command prompt by selecting Applications>Accessories>Terminal.

2. At the command prompt, type:

cd ~/Desktop

and press enter. 

3. Then type:

su

and press enter. Then type the root password.

4. Change the permission of the file you downloaded to be executable. Type: 

chmod +x voisus-client-v5.x.y.bin

where v5.x.y refers to the Voisus client version you just downloaded. 

Press enter.

For Example: To install voisus-client-v5.2.10, the above command will become

chmod +x voisus-client-v5.2.10.bin

5. Run the self-extracting binary by typing:

./voisus-client-v5.x.y.bin

Press enter. When the installation has completed, you will see the word ‘Done.’
Copyright © 2013 Advanced Simulation Technology inc. 61



ASTi Voisus Server Operator Manual (Ver. 1, Rev. L)
6. The installation is now complete. Reboot your computer so settings can take effect.

7. Open Voisus Client by selecting Applications>Internet>ASTi Voisus.You can also drag 
the ASTi Voisus icon to the desktop. 
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3.3. Desktop Client

The Desktop Client was designed for use on a desktop 
computer. The interface provides the runtime 
communications control settings (receive and transmit 
access) for each radio on the network. 

The Desktop Client GUI displays:

• Radios: The current net name with up to 8 radios 
available.

• RX/TX: Displays comms status for Receive or 
Transmit for each radio.

• Volume: The volume control for each radio. There is 
also a master volume control. 

For a smaller footprint, the GUI is collapsible by clicking 
the arrow button. Select the orientation under the settings 
preferences.
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3.3.1. Settings

SettingsSelect the ASTi logo button to view the settings.

Connecting to the Server

The standard connection mode for Voisus Server is 
client (server-based radios) mode. The standalone 
mode does not provide the centralized configuration 
and management that is available in the server-client 
mode. A separate license file is required for standalone 
mode. Contact ASTi for details.

Follow the steps below to connect the client to the 
server over the network.

1. In Settings > Preferences, select the client 
connection mode

.
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2. Enter the server’s IP address.

3. Enter a Client name. This name will appear on the Voisus Server status pages and will also 
be viewed by other clients. 

4. Click the Connect button to view the list of roles available on the server. 

5. Select an operator role and click the Connect button. 

6. You may be able to select a role if it is not pre-set in the server software configuration. The 
green status button appears when the client is connected to a role.
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7. For remote clients with limited bandwidth capabilities, change the Audio Quality setting 
from high bandwidth to low bandwidth to reduce possible audio breakup. 

8. Only one radio can transmit at a time unless the Allow Multiple Transmit checkbox is 
selected.

9. Set the orientation for the GUI in collapsed mode.

See “Locking Client Settings” below for information on password-protected settings.
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Headset Settings

Embedded functionality allows operators to adjust radio settings such as volume, sidetone and 
vox levels. There are headset presets for the Plantronics USB headset and for the ASTi Radius. 
Select the preset for your headset, click Set Preset, and then adjust the settings as necessary. 

Sidetone volume sets the level for hearing your own voice feedback during transmissions. In 
order to hear sidetone, a radio must be enabled and your headset device must support sidetone 
(see APPENDIX C: USB ADAPTERS AND HEADSETS).

Vox threshold allows for automatic transmission of voice without having to push a PTT button. 
The vox is voice activated and is dependent upon the threshold level. The higher the vox level, the 
louder the voice must be to transmit, so output is active only when the voice level exceeds the 
threshold. The lower the vox level, the more easily a voice is transmitted. In other words, output is 
active at a lower level.

Adjust the earphone, mic, sidetone, and vox settings to a comfortable level using the sidetone test. 
To test the headset use the headset test which plays a sinewave to check the sound device.

If there is a hardware PTT connected to the computer it will appear in the drop-down menu under 
‘Hardware PTT Options’. Select the button that will be used on the PTT. To confirm the hardware 
PTT is working properly, the word ‘Pressed’ will appear (as shown below) when the proper PTT 
button is pressed. 
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Peers

The Peers tab displays the client’s name, networked server and the associated clients’ roles. 
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About

The About tab displays the Voisus software version. Click the Display Log button to view details 
about the software’s status. Click the Export Debugging Info button to download the logs to the 
client computer. This is primarily used for ASTi troubleshooting. 
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Auto Radio Tuning

Auto radio tuning enables operators to instantly establish voice communications with any 
simulated radio on the network simply by clicking on a realtime list of “who’s online.”

Auto Radio Tuning replaces the traditional manual tuning method where operators were required 
to have prior, detailed knowledge of radio settings (frequency, AM or FM, crypto and frequency 
hop fills) to tune their radios. It also eliminates the need to preconfigure radios by filling them 
with pre-planned, coordinated settings prior to use.

Important: Auto Radio Tuning control is enabled by default on standard Voisus platforms. If the 
IA Maintenance software package is installed, the Auto Radio Tuning control interface is disabled 
by default and must be enabled to function. See APPENDIX D: INFORMATION ASSURANCE 
FEATURE CONTROL for additional information.

Operation

In RMS, the comm plan role must be configured properly to enable the Autotune feature. Open 
your Comm Plan and click the Roles tab. For each role, select the Enable Autotune checkbox. 
This allows any client with this role to have the ability to autotune. 
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In the Voisus Client application, operators simply access a list of active radios on the network, and 
then click on the radio they wish to communicate with. Auto Radio Tuning uses the selected 
radio's settings to automatically configure the operator's local radio.
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Locking Client Settings

The administrator can lock the client settings to prevent users from making changes. This lock 
feature allows users to communicate over the set nets but requires a password to enter the settings 
screens.

To set the password, navigate to ‘Preferences’ and select the “Require Password for Settings 
Window” checkbox.

Enter a password with 6 characters or greater. 
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After the password is set, any settings changes will require a password. 

What if I forgot my Voisus Client password? 

In the event of a forgotten password, you can manually change the password or remove the need 
to enter a password to open the settings window. 

The password is stored in the text file voisus_gui.ini and can be found in the following default 
locations:

Windows 7 and Windows Vista: C:\Users\<user name>\AppData\Local\VoisusCli-
ent\voisus_gui.ini

Windows XP: C:\Documents and Settings\<user name>\Local Settings\Application

Data\VoisusClient

Linux: ~/.voisus/voisus_gui.ini

To turn off the required password, change the following line in voisus_gui.ini:

Existing: ‘require_password = 1’

Change to: ‘require_password = 0’

Note: Do not include the quotes.

To change the password, open voisus_gui.ini in a text editor of your choice (e.g. NotePad, 
WordPad, Vi, etc). Look for the line that begins with:

password = abcxyz

Anything after the ‘=’ sign is the current password. In the example above the password is 
‘abcxyz.’ You can either modify the existing password in the text editor or use the existing 
password to open the settings window of the Voisus Client and change the password through the 
password change GUI.

For Windows users there is an alternative way to reset the password by un-installing the Voisus 
Client and reinstalling it. This will remove all saved settings (such as password, last connected 
Voisus Server, etc). This option is not available for Linux users.
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3.4. Tablet FullScreen Client

The Tablet FullScreen Client is similar to the Desktop Client, but it is optimized for touch devices 
with smaller screens

The Tablet FullScreen Client GUI displays:

• Radios: The current net name with up to 8 radios available.

• RX/TX: Displays comms status for receive or transmit for each radio.

• Volume: Volume control for each radio.

Tap the ASTi logo button in the upper right corner to access the settings menu.
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Settings

Tap the ASTi logo button to access the settings menu.

Connection Settings

1. Enter the server’s host name or IPv4 address.

2. Enter a client name.

3. Tap the Connect button to view the list of roles available on the server.

4. Choose an Operator Role and tap Connect again. The status at the top of the screen will 
confirm successful connection.

Headset Settings

1. Adjust Microphone and Earphone volume as desired.

2. Enable Multiple Transmit if desired. This allows the operator to transmit over more than 
one radio at once.

Misc Settings

1. Position the PTT button on the left or right side of the screen, or turn it off.

2. Require a password for the settings window if desired.
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3.5. Tablet Voisus App

The Tablet Voisus App includes: 

• A radio skin for the PRC-117F (see PRC-117F Radio Skins, below). 

• Remote Radio Control (see section 7.2.5. Tablet Voisus App for details).

• Compatibility with ACENet devices (see ACENet Devices, below).

The Tablet Voisus App GUI displays:

• Radios: The current net name with up to 8 radios available. 

• RX/TX: Displays comms status for receive or transmit for each radio.

• Volume: Volume control for each radio.

Tap the Settings button on the lower right side to access the Settings menu.
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Connection

1. Client Name: Enter a name for your client. 

2. Connect to Server: Enter the IPv4 address or ASTi Cloud ID of your Voisus server and 
tap Connect.

3. Role: Select a role and tap Set Role. (If no roles are available, the client may be locked in 
RMS. Check Scenario > Software Clients to see if that is the case.)
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Transmit

1. Mic Mode: select your desired mode.

Note: “Voice Activated (VOX)” includes both Press-To-Talk and VOX-activated mic if 
the VOX threshold is exceeded.

2. PTT Configuration 

• On-Screen Button: choose the location of your on-screen PTT button

• Keyboard: choose a keybinding to use as a PTT.

• Hardware: choose a device and button for PTT if hardware will be used.

3. PTT State: Test your PTT, and this field will give a visual indication that the PTT has 
been activated.
78 Copyright © 2013 Advanced Simulation Technology inc.



ASTi Voisus Server Operator Manual (Ver. 1, Rev. L)
Audio

Use the audio presets and adjust the levels as desired. The Apply button will return the selected 
preset to its factory settings.
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About

The About tab displays the Voisus software version. Tap “View Log” to view details about the 
software’s status. Change the password if desired.

Tap the Radios button in the upper right to exit the Settings menu.
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PRC-117F Radio Skins

A PRC-117F radio skin is available for a radio when it displays the PRC-117F text in its box (see 
below.) To access the skin, tap the desired radio button. 

Radios are defined as PRC-117F or Generic in RMS. Navigate to Comm Plan > Roles and click 
“Show Asset Nets”. Adjust the Radio Type for each radio in a role. See Asset Configuration in 
section 2.4.1.2. Roles for more details.
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The PRC-117F knob has three functional settings: Off, PT, and CT. The VOL and PRE buttons on 
the keypad are also functional. Use the PRE button to scroll through the available net list.

PT

PT stands for Plain Text. Use this setting to simulate non-encrypted communications.

CT

CT stands for Cipher Text. Use this setting to simulate encrypted communications. In the Comm 
Plan section of RMS, you must create a crypto-capable net to function with the CT setting.
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ACENet Devices

You can assign an ACENet device to an operator for use with the Tablet Voisus App. To do this 
you will need to configure the device in RMS.

Configuration:

1. In RMS, create or edit a Comm Plan with all of your desired nets and roles. Be sure to 
save your changes before proceeding.

2. On the Facilities page, create or open an existing Facility.

a. Click the Software Clients tab and select Yes for “Use ASTi hardware for audio I/
O?”

b. Either manually enter the client names or use the “Add All to Facility” button if 
clients are already connected to the server.

c. Save changes.
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3. On the Scenarios page, open an existing Scenario or create a new one.

a. Assign the Comm Plan and Facility you just created to this Scenario using the 
drop-down menus.

b. Click the Software Clients tab and select Yes for “Lock Software Clients?”

c. The software clients page will display the list of clients from the facility page. 
Click the green “+” next to each client to add it to the Scenario.

d. Once the client has been added to the Scenario you can assign it a role from the 
associated Comm Plan.

e. Once all of the roles have been mapped to clients, save your changes and click the 
“Install Scenario” button.

Operation

1. To operate, open the client and connect it to the Voisus server.

2. Select an asset on the client GUI for TX and use the headset connected to the ACE-RUI to 
communicate with other operators.

Note: The volume controls for each asset on the GUI will affect the received volume. 
Adjusting the Audio controls on the Settings tab has no effect on the audio.
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Troubleshooting

If the operator cannot RX or TX, verify that the ACENet device is attached.

1. In RMS, navigate to Monitor > Discovery to verify that the ACENet device is attached.

• If the ACENet device does not appear, check the ACENet cabling, switch and 
associated power supplies.

2. Navigate to Monitor > ACENet to verify that the ACENet device is properly configured 
for use in the Facility and Scenario.

• If the device does not appear, check the Facility page for proper assignment to a client 
name.

• If the names are correct, reinstall the Scenario or power cycling the ACE-RIU.

If the operator still cannot RX or TX, verify the client name and ACENet device association. The 
client name used in the tablet or PC must exactly match what is listed in the Facility and Scenario. 
The name is case-sensitive.
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3.6. Tablet TOCNET CAU Client

This software client simulates the interface of the Tactical Operations Center InterCommunication 
System (TOCNET) desktop Crew Access Unit (CAU). It is optimized for use on a tablet 
computer.

RMS Configuration

First, configure your Comm Plan and Scenario in RMS (see section 2.4. Configure 
Communications in RMS for more details):

1. Navigate to the Comm Plan page.

a. Create nets.

b. Create roles and assign nets to the individual assets of each role. We strongly 
recommend that you name each role “OPR-####” (see example below) and assign 
a separate role to each client (see step 3c below). These role names will best 
display on the client.   

c. Click “Show Asset Config” and adjust Rx Tx settings and Default Nets as desired.

d. Save changes.
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2. On the Facility page:

a. Load an existing Facility or create a new one.

b. Click the Software Clients tab and add client names. Note: The client names 
entered here MUST match the client names that are entered when you set up each 
client. This will link the software client to the client information you have 
configured in RMS.

c. Save changes.
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3. On the Scenario page:

a. Select an existing Scenario or create a new one.

b. Select your Comm Plan and Facility.

c. Click the Software Clients tab. We recommend that you lock the clients and assign 
each client its own uniquely named default role. The name of the role (not the 
client name) displays at the top of the client screen. Providing a uniquely named 
role to each client will result in a unique display name on each client. 

d. Save changes and click “Install Scenario.”
88 Copyright © 2013 Advanced Simulation Technology inc.



ASTi Voisus Server Operator Manual (Ver. 1, Rev. L)
Client Configuration

To configure and operate the Tablet TOCNET CAU Client, follow the instructions below. 

1. Install the Tablet TOCNET CAU Client as described in section 3.2. Client Software 
Installation.

2. Open the client and tap “Connect to Server.”
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3. Enter a client name. Remember, this client name must match a client name that you 
created in RMS on the Facilities > Software Clients page (step 2b in “RMS 
Configuration” above).

4. Tap CONNECT BY IP to connect to the server using the IP address. Tap CONNECT BY 
NAME if you would prefer to use the host name.

5. Once connected, you will return to the home screen. Tap “Continue”.
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6. This will display the SELECT ID screen. Use the up and down arrows to select a role. If 
the client was locked in RMS (step 3c in “RMS Configuration” above), only one role will 
be available. Tap “Select”.
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7. This will display the MAIN screen. Tap ID SCREEN to return to the SELECT ID screen 
(step 6). Tap OPERATE to access the ACTIVE ASSETS screen (step 8).  
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8. On the ACTIVE ASSETS screen, tap an asset to select it. Use the up and down arrows to 
find other assets (if there are more than what fits on the screen). Tap XMT for transmit 
select and MON for receive select. Tap VOL to adjust the volume. 
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3.7. Call Intercoms

The Voisus call intercom feature provides a private communication line between two or more 
clients. Simply invite a client to chat and wait for them to accept. Then communicate in real-time 
over the network.

For example, the administrator wants to chat with an operator without having to use radio/
intercom assets or interrupt an exercise. The administrator will send an invitation to a client on the 
network and wait for the client to accept. Once the invitation is accepted, the administrator and 
client can begin chatting. The client’s radio transmit mode is disabled while on a call; however, 
the receive mode remains enabled so the client can hear radio/intercom assets. 

Call Intercoms are available on the following software clients:

• Desktop Client (Windows and Linux)

• Tablet FullScreen Client

• Tablet Voisus App
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Enable/Disable Calling

Calling is enabled by default on all roles. To disable calling, navigate to the Comm Plan page in 
RMS and click the Roles tab. Select a role and click the “Enable Calling” checkbox.
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Setup and Configuration

Calling is easily set up on each client.

1. In the client’s Settings under Preferences, enter the Voisus Server’s IP address. 

2. Enter the client name. This is the username that is used for calling. 

3. Click the Connect button.

4. Once connected you can select an Operator Role. The Operator Role is configured via the 
Voisus Server Comm Plan.

5. Click the Connect button again.. 
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6. From the Voisus Client, click the phone icon to open the call list. View the client names in 
the call list.

7. To invite a peer to chat, select the name to send an invite to the other person. 
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8. Wait for the client to accept. Then the screen will display “On Call with . . .” 

9. To add an additional person to the chat, select the name in the call list. 

Once connected, the client is automatically on hot mic and may begin communicating. 

View the Peer list to see the list of peers available for chat. 
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3.8. Client FAQs

Q: Can client radios interact with all other DIS radios on the network? 

A: Yes, including all ASTi systems (Telestra 4 ACE, Telestra 3 MBV, DACS, and PC’ver) and 
third party radios. Voisus Technology supports all radio types that are supported in ACE, 
including AM, FM, VoIP, network intercoms, SATCOM, SINCGARS, and HAVE QUICK.

Q: How many client operators can connect to one server? 

A: The limitations are determined by the model size and loading on the server. Contact ASTi to 
discuss your specific requirements. 

Q: What is the Voisus software loading on the client and server?

A: The software loading on the client workstation will vary depending on the client PC hardware 
and the number of active radios, but typically CPU utilization will be between 1-10 percent. The 
loading on the server with 8 operators with 8 radios each is approximately 15 percent. 
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3.9. Client Security Firewall Configuration

3.9.1. RedHat Enterprise Linux

If security standards require enabling the firewall, follow the steps below to create a path for the 
network. 

1. Navigate to System > Administration > Security Level and Firewall. 

2. The prompt will ask for the ‘root’ user password. Enter the root password. 
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3. The Security Level Configuration screen will open. Select Firewall > Enabled. 

4. Select the arrow to expand ‘Other ports’. Select the ‘Add’ button to add a port. The default 
port is 31929. 

5. Set the port and the protocol to the port used on the server. This is the same port number 
set during the client installation. 

6. Save changes and close window. 
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3.9.2. Microsoft® Windows®

Firewalls in Windows may vary depending on system requirements, see your system 
administrator. 

During software installation, click “Unblock” in the Windows Security Alert window.
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3.10. Client Lockdown in RMS

In the Remote Management System, administrators can add global controls for software client 
operators. The client’s role and DIS domain can be set and locked for each operator.

Note: Adding software client settings in the Facility and Scenario is optional. These steps are only 
required if you wish to lock down the software clients.

See “Locking Client Settings” in section 3.3. Desktop Client for information on password-locking 
the Voisus Desktop Client.

Step 1: Comm Plan

Start by creating a comm plan and roles or select the Basic_Example comm plan. For more about 
comm plan and roles see section 2.4.1. Comm Plans & Roles.

Note: If you plan on modifying any of the bundled examples and use them on a day to day basis as 
part of your operations, it is recommended that you use the “Save As” function to create new 
comm plans, scenarios, and facilities as needed, so that you keep the provided examples in their 
original state.
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Step 2: Facility 

1. Navigate to the Facility page. Create a new facility or open an existing facility.

2. Select the ‘Software Clients’ tab. 

3. Enter the name for each client operator. 

Note: This username must match the name used in the Voisus Client application. 

4. If existing clients are connected over the network to the server they will appear under the 
‘Online Clients’. Select to add them to the facility if they require role and DIS Domain 
lockdown.

5. Select the ‘Save Changes’ button.
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Step 3: Scenario

1. Navigate to the Scenario page. Create a new scenario or open an existing scenario. Select 
the comm plan and facility from the steps above. 

2. Select the ‘Software Clients’ tab. Then select ‘Yes’ if you wish to lock down the software 
clients.
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3. After ‘Yes’ is selected, the software client names that were added in the Facility will 
appear under the ‘Client List’. Select the roles for each client. Select the ‘DIS Domain’. 

4. Check the ‘Lock’ box if you do not want the client operator to be able to access other 
roles.

5. If not all client names are known, then allow unlisted clients to connect to the server. This 
allows any client connected over the network to connect to the server. You may select a 
default role and DIS Domain for unknown clients.

6. Save changes and install the scenario. 
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SECTION 4.0. VBS2 PLUGIN
Virtual BattlespaceTM 2 (VBS2) users can employ ASTi’s full-fidelity radio simulation and com-
munications capabilities within VBS2’s interactive, three-dimensional training system. Users will 
gain the enhanced training benefits of a highly realistic simulated radio environment with the 
introduction of ASTi radios into VBS2.

The Voisus-VBS2 plugin integrates the Voisus Client directly into the VBS2 game environment. 
Each VBS2 player is configured with one or more communication assets such as radios or inter-
coms. While in a mission, the player has a Heads Up Display (HUD) showing all the necessary 
information about their radios including current net selections and transmit/receive status. In addi-
tion to player radios, in-game vehicles can also be assigned radios which players can use when 
they are within the vehicle. These unique features allows realistic dismounted training.

ASTi’s Earshot increases gaming realism, as only talkers within acoustic in-game range can com-
municate. Earshot works automatically when using geolocated maps in VBS2 – there is nothing to 
configure. Earshot uses a highly accurate physics model to constantly adjust the reception of play-
ers’ voices based on the distance between voices and the volume of voices.
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4.1. Voisus-VBS2 Plugin Elements

ASTi's Voisus-VBS2 Plugin comprises four important elements that are included in the Voisus-
VBS2 installation package.

Voisus VBS2 Manager

The Voisus VBS2 Manager is a program designed to help install and manage the integration 
between Voisus and VBS2. This program looks for existing VBS2 installations and missions and, 
if found, will allow you to easily activate or deactivate Voisus for those installations and missions. 

ASTivoisus.dll Plugin

This provides the communication between Voisus Client's audio and networking libraries and the 
VBS2 application. This file is installed in your VBS2 plugins directory via the Voisus VBS2 Man-
ager. There is a DLL file for every game install instance.

ASTivoisus.pbo VBS2 Add On

This file contains the necessary VBS2 scripts and user interface elements to properly display Voi-
sus information in-game. This file is installed in your VBS2 add-ons directory via Voisus VBS2 
Manager.

Advanced Setting - ASTi init.sqf Mission File

The VBS2 mission initialization script allows users to define additional keyboard bindings. This 
script is customizable so users can select which keyboard bindings to use for actions such as push-
to-talk, selecting nets, muting radios, etc.

4.2. Voisus-VBS2 Plugin Requirements

ASTi Voisus-VBS2 plugin requirements:

• One of the following Windows® versions:

• Windows®XP 32-bit with service pack 2 or 3

• Windows® Vista 32 and 64 bit

• Windows® 7 32 and 64 bit

• Voisus Server

• USB Headset

• For ASTi vehicle radios, properly configured LVC for DIS interoperation

The Voisus-VBS2 plugin operates with VBS2 versions 1.4 and 1.5.
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4.3. Installation Steps

Follow the steps below to install the Voisus VBS2 Plugin.

Step 1: Install Virtual Battlespace 2

Install Bohemia Interactive’s Virtual Battlespace 2. For more information see http://www.bisimu-
lations.com/. 

Step 2: Install Voisus Client

Install the Voisus Client by following the installation instructions in section 3.2. Client Software 
Installation. 

Step 3: Install Voisus-VBS2 Plugin

Follow the steps below to install the Voisus-VBS2 Plugin on a Windows® OS. 

1. Open RMS and navigate to the Voisus Downloads screen. Select the Voisus plugin for 
VBS2.

Note: For more information on opening RMS, see section 2.1. Access RMS. 

2. Save the file and double-click the downloaded file (VoisusVBS2ManagerSetup_x_y.exe 
where x_y is the version number). 

You may get a warning similar to the screen below depending on your Windows® version.
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3. Run the file. 

4. Follow the Voisus VBS2 Manager installer. Select ‘Next’.

5. Select the location. The default installation path is shown below. 
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6. Click ‘Install.’

7. Wait as the Voisus VBS2 Manager installs. 
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8. Click ‘Finish’ and launch the Voisus VBS2 Manager.

9. The Voisus VBS2 Manager finds all of the VBS2 installations and missions on the 
computer. Select to ‘Enable Voisus for X installations and Y missions’ if you would like 
Voisus installed on all VBS2 installations and missions found.

To install Voisus on specific installations and missions, select ‘Manage installations and 
missions’ and continue to step 10. 

To enable Voisus you must first enter the IPv4 address of the Voisus Server.

Note: If you do not know the IP address you may enter a placeholder address and relaunch 
the manager at a later time to enter the Voisus Server IP address. The IP address is 
required for communications.   
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10. To install Voisus on specific installations or missions, select ‘Add VBS2 Installation.’ You 
can also do this to confirm the Voisus VBS2 plugin was installed into the proper VBS2 
installation directory.

Confirm your VBS2 installation has active Voisus comms indicated by a green check 
mark. If there is not a green check, highlight the item and select ‘Enable.’

If you see a red exclamation mark icon under ‘Voisus Enabled,’ your Voisus VBS2 plugin 
has an update available. 
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11. To add a VBS2 installation, select ‘Add VBS2 Installation’ and navigate to the VBS2 
installation directory you would like to add. 

12. Select the ‘vbs2.exe’ and select ‘Add’.
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13. Navigate to the ‘Missions (Server Only)’ tab. Select the VBS2 missions that you would 
like to set up with Voisus communications. 

14. Set the Voisus Server IP address and select to activate the Voisus communications.

Note: If you enter IP address 0.0.0.0, VBS2 Voisus will connect to its previous Voisus 
Server. 
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Step 4: Disable VBS2 Keybindings

In this step, you will disable the keys that are necessary for Voisus control. You must do this for 
each VBS2 profile used. This is not for all VBS2 keybindings. Only a small subset is required for 
Voisus.

Important: Disabling the VBS2 keybindings is imperative to the audio quality of the Voisus 
software. 

1.  Open VBS2 and navigate to Options > Controls.

2. Scroll down the list until you see “Voice Over Net” and “Push to Talk”.

3. Select “Push to Talk” which opens the “Configuring Actions” screen for Push to Talk’s 
keybindings. 
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4. Highlight the comma (“Caps Locks”) and select “Delete.” 

5. Select “Voice Over Net” and repeat the two steps above.

Note: For VBS2 2.xx, repeat step 5 for “Next Channel,” “Chat,” and “Previous Channel.”

6. Select “OK” when you are finished. 
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Step 5: Set up the Dedicated Server

This step is for dedicated servers only. Ensure that Step 3: Install Voisus-VBS2 Plugin is com-
plete with the Voisus comms activated for the mission(s) and VBS2 installation before following 
the steps below.

1. Open VBS2 Admin and open the Mission Editor on the left side of the screen.

2. Select the terrain on which the mission is based and open the editor. You must export the 
mission to networked scenarios and ensure the resulting PBO file (now with active Voisus 
comms) is in the proper place. 

3. Once the terrain is loaded, choose File > Load and select the mission. Once loaded, you 
should see the mission units overlaid on the terrain.

4. Choose File > Save. In the dialog box, enter a mission name, title and description (or leave 
them as they were). In the Export option, select “Export to Network Scenarios”. Once 
chosen, click “Ok.” By default, Export to Network Scenarios will create a packaged 
mission PBO file in the following directory:

C:\Bohemia Interactive\VBS2\mpmissions

5. Close VBS2.

6. By default, a dedicated server will make all PBO files located in this file available to 
clients.

C:\Bohemia Interactive\VBS2\mpmissions 

However, VBS2 administrators are able to limit which missions are available to play. 
Check with your VBS2 administrator to ensure that the new PBO mission file you created 
in step 4 is in the proper directory and that the dedicated server is configured to allow your 
mission to be available to clients.

7. Launch the VBS2 dedicated server and use one or more clients to connect to the mission 
you just created.

If using LVC for DIS radio traffic continue to Step 6: Attach ASTi Radios to VBS2 Vehicles. If 
not, skip ahead to Step 7: Selecting a Role. 
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Step 6: Attach ASTi Radios to VBS2 Vehicles

Vehicle Naming Requirements

ASTi Radios are attached to VBS2 Vehicles using DIS. In the next step, you will configure 
VBS2’s LVC to publish DIS packets on the same network and DIS exercise as the Voisus Server. 
ASTi Vehicle Radios are configured to attach to DIS Entities by Marking Field (or URN in 
VBS2). If a VBS2 Vehicle has the same URN as an ASTi Vehicle Instance, then the radios will be 
tied to the VBS2 Vehicle and when a player gets in the vehicle, he will gain access to the vehicle 
radios.

If this is the first time configuring VBS2 to use LVC/DIS networking, continue on to the next 
step. 

1. In the RMS comm plan, configure Vehicle Roles as shown in section 2.4.1.2. Roles. For 
example, if your VBS2 mission has two types of vehicles, Stryker and MRAP, create two 
Vehicle roles with communication assets.

2. Navigate to the Scenario page to create Vehicle instances. For example, if your VBS2 
mission has two Strykers and three MRAPs, you will need to create five Vehicles. Three 
will have the Vehicle Role of "MRAP" and two will have the Vehicle Role of "Stryker". 
 The Vehicle names you assign will need to match the Marking Field (or VBS2 Object 
URN) of the corresponding VBS2 Vehicles.

3. Select the ‘Vehicles’ tab and add the vehicles. 
Copyright © 2013 Advanced Simulation Technology inc. 119



ASTi Voisus Server Operator Manual (Ver. 1, Rev. L)
4. Save and install the changes. 

5. Assign matching URNs to VBS2 vehicles. To do this, select ‘Mission Editor’ from the left 
hand side of the VBS2 default screen. Select the terrain where the mission is located. Once 
the editor has loaded, select File > Open and select your specific mission. To edit a 
vehicle’s properties, right-click on the vehicle and select ‘Edit Object.’ Assign the vehicle 
name chosen in step 2 (above) to the URN Marking field and URN Marking LVC field. 

a. Open VBS2 Admin and open the Mission Editor on the left side of the screen.

b. Select the terrain on which the mission is based and open the editor. 
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c. Once the terrain is loaded, choose File > Load and select the mission. Once loaded, 
you should see the mission units overlaid on the terrain.

d. Select the vehicles to receive Voisus comms attachment. Ensure the URN Marking 
field and URN Marking LVC field match the vehicle instance names set in steps 1-
3. 

e. Choose File > Save. In the dialog box, enter a mission name, title and description 
(or leave them as they were). In the Export option, select “Export to Network Sce-
narios”. Once chosen, click “Ok.” By default, Export to Network Scenarios will 
create a packaged mission .pbo file in the following directory:

C:\Bohemia Interactive\VBS2\mpmissions

f. Close VBS2.

g. By default, a dedicated server will make all .pbo files located in this file available 
to clients.

C:\Bohemia Interactive\VBS2\mpmissions 

However, VBS2 administrators are able to limit which missions are available to 
play. Check with your VBS2 administrator to ensure that the new .pbo mission file 
you created in step 3d is in the proper directory and that the dedicated server is 
configured to allow your mission to be available to clients.

h. Launch the VBS2 dedicated server and use one or more clients to connect to the 
mission you just created.

Note: Vehicle instances created in the Scenario with a common Vehicle Role will have the same 
communication assets. For many users, this greatly simplifies system configuration. However, if 
each vehicle instance needs to have a private intercom only for that vehicle, users will need to 
define a different Vehicle Role for each Vehicle that requires unique communications configura-
tion.
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LVC Game Setup for DIS

Important: This step is for the VBS2 server only. Ensure that the VBS2 host is not running before 
continuing. 

1. Update the shortcut to use the LVC Game by right-clicking on the VBS2 admin shortcut. 
Then select properties and in the target field add ‘-lvc’ after ‘-admin’. Then select ‘Ok’. 

2. Navigate to the VBS2 Installation directory and find the ‘config’ folder. The directory can 
be found here (valid for Windows XP, Vista, and 7): 

C:\Bohemia Interactive\VBS2 VTK\config

3. Open the ‘vbsClient.config’ file in a text editor (i.e. WordPad). 

4. Find the line that starts with ‘Plugins’.

a. Follow the steps for your operating system.

Windows Vista/7

Ensure that the line below is in the file, if not then type it in.

DIS.dll : DIS\DIS.config

Be sure to comment out (or delete) any LVCWebInterface entry, if present, as 
shown below.

Windows XP

Ensure that the line below is in the file, if not then type it in.

DIS.dll : DIS\DIS.config
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Note there may be a LVCWebInterface.dll entry on the Plugins line. If it is 
there, leave it as is. If it is not present, do not add it.

b. Save and exit the file.
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5. Navigate to the DIS folder from the config folder. The directory can be found here (valid 
for Windows XP, Vista and 7): 

C:\Bohemia Interactive\VBS2 VTK\config\DIS

Open the DIS.config file in a text editor (i.e. WordPad). 

6. If you have more than one interface, enter the broadcast address of the interface after 
‘dis.address=’. Note: if there is only one interface, leave this space blank. 

7. If you wish to change the send and receive port numbers, edit the ‘dis.sendport=’ and 
‘dis.receiveport=’ fields or use the default 3000.

8. For more information about configuring the DIS Exercise of your Voisus Server, see 
section 2.2.5. DIS Settings. 

In DIS.config, modify the remaining DIS configuration to match the exercise parameters. 
At a minimum, the dis.exerciseID setting must match the Voisus Server DIS Exercise.

Important -: To ensure that the VBS2 LVC server can communicate with the Voisus 
Server:

• The Exercise ID in VBS2 must match the Voisus Server DIS Exercise ID. 

• The VBS2 DIS Port must match the Voisus Server DIS Port. 

• The VBS2 address should correspond to the Voisus Server DIS address (broadcast/mul-
ticast). 

9. Save and exit the file. 
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Step 7: Selecting a Role

The Role contains the operator’s radio assets that are previously assigned in the Voisus Server 
comm plan configuration. See section 2.4.1. Comm Plans & Roles for more details. 

This step must be performed by all VBS2 operators upon opening VBS2 and every time an opera-
tor needs to change Voisus roles. Once selected, a role will remain active until changed by the 
user. 

1. To open the Voisus options page, press ‘Alt +O’. Note: This is the default key 
combination. However, VBS2 administrators are capable of changing this key combo.

In the Voisus options page the user can:

• View and select available roles

• Change Voisus Server IP address

• Change radio and GUI settings

2. Select a role.

3. Click the Ok button.
Copyright © 2013 Advanced Simulation Technology inc. 125



ASTi Voisus Server Operator Manual (Ver. 1, Rev. L)
4.4. Communicating in VBS2

Nets

Nets are configured in the comm plan by system administrators. Some nets may be locked to pre-
vent users from switching radios. Nets may also be set to receive-only mode. When a radio is in 
receive-only mode the user is unable to mute or transmit on the radio. 

In the example below, “All Call” is locked and also is in receive-only mode. 

Ranging and Propagation Loss

VBS2 players with Voisus radios will experience ranging and propagation loss with certain geolo-
cated maps, i.e. the player’s position is tied to the radios. This is available in software versions 
5.2.6. and later. Contact ASTi for more details.
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4.5. Keys and Advanced Settings

ASTi Keybinding Map

The default ASTi keybindings are shown below. 

1 2 3 4 5 6 7 8 9 0~

Q W E R T Y U I O P [ ]

\‘;LKJHGFDSA

Z X C V B N M , . /

Tab

Caps
Lock

Shift

Ctrl Alt Space Alt

Shift

Ctrl

Enter

Backspace- +

Earshot PTT: Tab
Radio PTT: Caps Lock
Mute Selected Net: k
Open Voisus Options: Alt + O

Open Simscribe Options: Shift + Alt + H
Change Radio: /
Net + :  . (period)
Net - : , (comma)   

VBS2 Client Radio Key
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Set Custom Keybindings

Important: This step is only required for the VBS2 host computer or dedicated server. These 
steps must be completed for every VBS2 mission that will use Voisus. 

1. In the Voisus VBS2 Manager select the ‘Missions (Server-Only)’ tab and select the 
mission(s) that need keybinding changes. 

2. Select ‘Configure Keybindings’ as shown below. 

3. Select the ‘Change’ button for the command you wish to change. 
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4. A pop-up will open telling you to press the key to bind the action. 

Confirm the proper keybinding appears. 

5. Once you have changed the keybindings, select the button ‘Update settings for X 
mission(s)’ to save the changes. 
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DIS Mapping for Vehicle Positions

For proper Earshot and vehicle behavior, the user must ensure that their vehicles have DIS entity 
mappings for use with vehicle positioning. VBS2 only outputs entity positions for vehicles if they 
have a DIS mapping (enumeration). Follow the steps below: 

1. Open the following file in a text editor:

<VBS2 installation directory>\config\vbsClient.config

2. In vbsClient.config, locate the line that begins with “Plugins = ”. Ensure that 
“LVCWebInterface.dll:LVCWebInterface\LVCWebInterface.config” is included as one of 
the plugins to load. Note the comma between different plugins.

For example, to use the DIS and LVC Web Interface the line should look like this:

Plugins = DIS.dll:DIS\DIS.config,LVCWebInterface.dll:LVCWebInterface\LVCWebIn-
terface.config

3. Open the following file in a text editor:

<VBS2 installation directory>\config\LVCWebInterface\LVCWebInterface.config

4. Find the line that starts with “LVCWebInterface.port = ” and take note of the port that 
follows the equal sign. The default value is 8100.

For example, the following line indicates port 8500:

LVCWebInterface.port = 8500

5. Temporarily turn off any local firewalls.

6. Launch VBS2 with -LVC and -admin options.

7. Once in VBS2, choose “Networking” followed by “New Session”. Press Alt-Tab to return 
to the Windows desktop and open a web browser.

8. Type the following into your web browser's address bar:

<your computer's IP address>:<port number from step 4>

For example, if your computer’s IP address is 10.2.100.100 and the port is 5000 you 
would type 10.2.100.100:5000
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9. On the left side of the page under “Entity Mapping” click “Outgoing”. Find the VBS2 unit 
type (listed under Game Internal Type) you wish to attach to Voisus radios. Note: You can 
sort the list by unit name.

10. Once you've located the vehicle type you want to use, click the corresponding row under 
“Enumeration”. Type in the desired DIS enumeration for the unit type. The entry will be 7 
numbers separated by a space.

Note: There are several restrictions on the values that can be used. The web page will 
reject invalid entries.

11. Restart your local firewall.

Important: The exact enumeration values do not matter when attaching Voisus radios to VBS2 
entities. However, enumeration values may be used by other DIS-capable simulators to represent 
in-game entities so depending on the DIS enumeration you use, it may affect other simulators.

To confirm that the mapping is in place when the VBS2 scenario is running, double-click on a 
vehicle radio in the radio monitor and check that there is a vehicle position (i.e. not 0x0x0).
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4.6. Troubleshooting Voisus with VBS2

If you are experiencing issues relating to the Voisus-VBS2 plugin, perform the following proce-
dures to determine the source of the problem and find a remedy. 

4.6.1. General Voisus-VBS2 Plugin Troubleshooting

1. If the Voisus-VBS2 GUI reports “No Response from Server”, check your mission init.sqf 
file or open the in-game options page (default key press is Alt+O) and make sure that the 
listed 'Server_IP' matches the network configuration for your server.

2. When upgrading or re-installing VBS2, you will need to un-install and reinstall the 
Voisus-VBS2 Plugin. To un-install the Voisus BS2 plugin: 

a. Deactivate all of the missions and installations via Voisus VBS2 Manager.

b. Hand edit the init.sqf files to remove the code between

/**** START ASTi VBS2 GUI CODE ****/

and

/**** END ASTi VBS2 GUI CODE ****/

c. Use the Windows control panel Program and Features (for Windows Vista and 7) 
or Add Remove Programs (for Windows XP) to remove the Voisus VBS2 Man-
ager.

3. The Voisus-VBS2 Plugin installer includes four important elements that are required for 
proper functionality. It is essential that all elements are in the proper file location.

a. Voisus VBS2 Manager

b. [VBS2 install directory] \ plugins \ ASTiVoisus.dll

c. [VBS2 install directory] \ My Content \ Add ons \ astivoisus.pbo

d. C:\Documents and Settings \ <username> \ Voisus \ VBS2  init. file 

4.6.2. USB/Headset Troubleshooting

1. If you experience any audio problems the first step is to check your audio device settings. 
For complete details see section 3.1.2. Choosing an Audio Device on the Client.

• Ensure that the proper audio device is selected for both sound playback and sound 
recording.

• Ensure that the Microphone > Advanced audio setting is set to 48 kHz.

2. If the headset was unplugged from the USB port:

a. Close the client and VBS2. Then plug the headset back in.

Note: It is good practice to plug the headset back into the same plug or you may 
have to reset the audio devices.

b. Reopen the client and VBS2.
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c. If issues persist, check audio settings as described in section 3.1.2. Choosing an 
Audio Device on the Client.

3. If you are using a USB PTT and it is interfering with the VBS2 game controls such as the 
gun fire, the user should change the controls in the VBS2 options configuration. If the user 
is going to be using a USB PTT, they will need to change the default VBS2 'Joystick' 
configuration.

a. Select your VBS2 profile.

b. Select ‘Options’ on the main menu.

c. Click ‘Controls’.
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d. Scroll down until you see ‘Fire’ and click on it.
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e. Select ‘Stick Btn. #1’ and press ‘Delete’.

f. Press ‘OK’ twice to return to the main screen.

Warning: Changing this control may interfere with other joysticks (steering wheels, 
etc).
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4.6.3. Keybindings Troubleshooting 

1. If you experience the following symptoms, the ASTi keybindings are not set correctly. 

a. The microphone icon or chat symbol shows up during the VBS2 game. 

b. The user hears echoing voices.

2. Refer to Step 4: Disable VBS2 Keybindings to reset the keybindings for all VBS2 user 
profiles that use Voisus.

4.6.4. Dedicated Server Mode

1. The Voisus-VBS2 Plugin interface is not showing up in the VBS2 display. 

a. Ensure Voisus client is installed on each VBS2 client computer. 

b. Ensure the ASTi init.sqf files was added to the proper mission folder.

2. What if I don’t want the VBS2 clients to connect to a single Voisus Server on VBS2 
mission start?

• Enter IP address 0.0.0.0. VBS2 Voisus will connect to its previous Voisus Server.

4.6.5. Voisus VBS2 Plugin Update Available

If you see a red exclamation mark icon under ‘Voisus Enabled’, your Voisus VBS2 plugin has an 
update available. This also may occur under the Missions tab. 
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Symptom: When starting a VBS2 mission, users are presented with the following error message:

Potential Problem: The current VBS2 mission has had Voisus communications activated for 
that mission but Voisus has not been activated for the VBS2 installation that is currently run-
ning.

Solution: Quit VBS2 and use the Voisus VBS2 Manager to activate the VBS2 installation you 
are currently using. See section 4.3. Installation Steps for more information on the Voisus 
VBS2 Manager. Restart VBS2 and relaunch your mission.

Symptom: ASTi GUI appears as available (either in game or Voisus Client) but the push-to-talk 
(PTT) is not working.

Potential Problem: The default audio device is not set properly or is already in use.

Solution: Open the ‘Sound Control’ panel, set the default audio device, and restart the game 
or Client. See the section 3.1.2. Choosing an Audio Device on the Client for details. You must 
close VBS2 and Voisus Client and then restart VBS2 and/or Voisus Client.

Symptom: 

1. The Voisus Client does not appear when using the dedicated server configuration.

- OR -

2. Changes to the init.sqf file(e.g. IP address, key bindings) do not appear to be updating. 

Potential Problem: The init.sqf was added or changed but the scenario was not loaded in 
VBS2 and re-saved with “Export to Network Scenarios” selected. 

Solution: Make changes to the init.sqf using the Voisus VBS2 Manager then open the mission 
in the VBS2 editor. Choose File > Save and be sure to select “Export to Network Scenarios”. 
See Step 5: Set up the Dedicated Server for more details. 

Symptom: Everyone in a VBS2 mission can hear the speech transmitted via Earshot regardless of 
the distance from the speaker. 

Potential Problem: TheVBS2 map is not set up as a geolocated map.

Solution: In VBS2 use the mission editor tools to geolocate the map in question. Refer to 
VBS2 documentation for more details on how to do this. 
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Symptom: Upon starting the Voisus Client the program crashes and presents the user with an 
error message stating that MSCVP100.DLL or MSCVR100.DLL is missing.

Potential Problem: The PC is running a version of Windows prior to the release of Windows 
XP Service Pack 2 without Windows Installer 3.1 installed.

Solution: Download and install the Windows update to install Windows Installer 3.1. See: 

http://www.microsoft.com/download/en/details.aspx?id=25

After the Windows installer is updated, uninstall Voisus Client and then reinstall the Voisus 
Client.
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SECTION 5.0. VOISUS HARDWARE CLIENT
In addition to Voisus Client lightweight software application for operators, Voisus Server also has 
hardware operator options including ASTi’s tactical radio simulators and hand-held terminals 
(HHTs). 

5.1. SINCGARS Configuration

This chapter describes the software configuration required for using the ASTi SINCGARS panel 
with Voisus Server. See the Simulated SINCGARS Panel Operator Guide for Voisus Server 
(DOC-VS-SINC-OG) for more information about the ASTi SINCGARS hardware panel.

5.1.1. Define Radios in Comm Plan

To configure an asset as a SINCGARS radio, nets must be added in the following order:

Cue, Man, SC1, SC2, SC3, SC4, SC5, SC6, FH1, FH2, FH3, FH4, FH5, FH6

The nets are populated up to the last one that is planned for use. For example, if the exercise only 
calls for 3 single-channel frequencies and no frequency hop nets, then simply add nets for Cue, 
Man, SC1, SC2, and SC3, and omit SC4 through FH6. Net names are not important for this setup, 
so they can be customized for the exercise. For example, the third net (SC1), could be named 
"Battalion Net" if desired. See below for an example role configured for use with two SINC-
GARS radios.

Only VHF-low frequencies are valid for the SINCGARS radio nets. This means all the nets, Cue 
through FH6, must have a frequency set between 30 MHz and 89.999 MHz. If a frequency is out 
of this range, receive and transmit will be disabled for that net. Frequency hop parameters like 
NetID determine if two frequency hop radios are in tune with each other. However, a VHF-low 
frequency must be configured for a frequency hop net to function.

Commonly, nets Cue, Man, and SC1-6 are configured with the SINCGARS_SC modulation type 
in the "waveform" section of the commplan. While FH1-6 nets use the SINCGARS modulation 
type. Contact ASTi for more details about configuring modulation types for interoperation with 
other simulators.
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5.1.2. Hardware Positions in Facility

The SINCGARS panels are configured as hardware positions in the RMS Facility page.
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5.2. PRC-117 Configuration

This chapter describes the software configuration required for using the ASTi PRC-117 panel 
with Voisus Server. See the Simulated PRC-117F Panel Operator Guide for Voisus Server (DOC-
VS-PRC117-OG) for more information about the ASTi PRC-117 hardware panel.

Important: PRC-117 control is enabled by default on standard Voisus platforms. If the IA Mainte-
nance software package is installed, the PRC-117 control interfaces are disabled by default and 
must be enabled to function. See APPENDIX D: INFORMATION ASSURANCE FEATURE 
CONTROL for additional information.

5.2.1. Define Radios in Comm Plan

To configure an asset as a PRC-117 radio, nets must be defined in the comm plan. You can define 
up to 100 nets for the PRC-117. If the net contains a waveform that is not valid for the PRC-117, 
the screen will display an invalid message, however, the panel will continue to have 
communications.
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5.2.2. Hardware Positions in Facility

The PRC-117 panels are configured as hardware positions in the RMS Facility page.
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SECTION 6.0. SIMSCRIBE
6.1. Introduction

Simscribe is a networked voice and radio communications capture and replay tool that serves a 
critical role in after action review of live, virtual, constructive and game-based training. 

Simscribe’s simple, intuitive web-based GUI is easy to use and has custom interfaces such as 
Virtual Battlespace 2 (VBS2TM) which allows the user to stay within their current environment 
and seamlessly interoperate with Simscribe. It supports local, network and operational live radios 
under a variety of standard simulation protocols.

Simscribe

Classroom, Serious Games, VBS2

Virtual Simulators

Live Radio Communications

PowerBook G4

After Action
Review

Call for 
Fire

Clear to 
Fire

Fire 
Confirmed

Call for 
Fire

Fire 
Confirmed

Clear to 
Fire

High Level Application Example
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6.2. Key Features

Simscribe features multiple user interface options:

• Simple and intuitive web-browser based controls including: play, pause, record, FWD/
RWD, load, save, discard and new

• VBS21 in-game AAR plugin launches automatically with VBS2 for seamless operation

• Simscribe Software Development Kit (SDK) available – contact ASTi for specific applica-
tion details

Feature Set

• Local, network and live radio capable

• Supports DIS protocol

• Supported audio playback modes:

• Local only or DIS Network

• DIS audio only or all DIS traffic

• Voisus Client

• Serious game communications AAR (VBS2)

• Radio simulators

• Hand-held terminals (HHTs)

Filtering Capability

• Recording

• DIS Gateway: Defines the core DIS parameters to filter (port, exercise, etc.)

• Playback

• Voisus Client: Filter up to 8 nets simultaneously

• Serious Game Communications AAR (VBS2): Filter up to 8 nets simultaneously

• Radio simulators

• Hand-held terminals (HHTs) 

1. Requires non-ASTi VBS2 game and license.
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6.3. Getting Started

Open a web browser and type in the IP address of the Voisus Server platform running Simscribe. 
Select the Simscribe application.
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6.3.1. Web-Based Interface Overview

When you first log in to the platform you should see a message as shown in the image below. The 
basic Simscribe controls are fairly intuitive and described below.

• The  rewind button is used during replay mode only. It is used to rewind the current 
recording. The rewind speed is intelligent and increases exponentially based on the duration 
of the button hold and the length of the recording.

• The forward button is used during replay mode only. It is used to fast forward the cur-
rent event. The forward speed is intelligent and increases exponentially based on the dura-
tion of the button hold and the length of the recording.

• The Record/Pause button is used during record mode only. When paused or starting a 
new recording, this will start or continue recording.When actively recording, this will pause 
the recording until recording is resumed.

• The Play/Pause button is used during playback mode only. If the current playback file 
is paused, this will resume playback. If the current playback file is playing, this will pause 
it.

• The Load button is used to load a previously saved recording.The user must first 
save or discard the current recording if in progress. Load a previous recording for playback.
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• The Save button is used in record mode only. Save the current recording for play-
back. The user will be required to enter a name for the recording. An optional date and time 
stamp can be added to the name if desired.

• The New button is used to start a new recording. The user must first save or discard 
the current recording if in progress.

• The Discard button is for record mode only. Discard your current recording. It will 
not be saved. This will allow you to start a new recording or play back a saved one. 

• The Add Bookmark button is used during record or playback modes. It allows 
users to mark a specific time in a recording. Once a bookmark is created, users can add a 
description and modify the time if necessary. For more information on bookmarks, see sec-
tion 5.3.6., Managing Bookmarks.

To the left side of the Simscribe user interface is a Help box that can be enabled or 
disabled. When enabled it will display useful information about the button or section of the 
Simscribe user interface the mouse is hovering over.
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6.3.2. Logger Setup

Simscribe is capable of capturing local and network DIS traffic.

Logger Setup
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6.3.2.1. Setting up the DIS Gateway for Logging
The DIS gateway configuration determines what local and network traffic is captured. The DIS 
gateway configuration is the same DIS configuration as used in the Voisus Server configuration. 
The gateway allows for the capture of local Voisus Server DIS radios, all networked DIS radios, 
and all DIS traffic. See section 2.2.5. DIS Settings for more information.
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6.3.3. Playback Setup

The Simscribe log can be played back in two ways:

1. Through clients connected to the local Voisus Server, or

2. Through clients connected to the local Voisus Server as well as other DIS clients, servers, 
or applications on the network.

Audio playback occurs through a Voisus Client, VBS2 plug-in, hardware client, or other DIS 
capable receiver(s) if DIS network replay is enabled. To enable or disable network replay see the 
following section.

6.3.3.1. Configuring Simscribe Preferences
The ‘Preferences’ page provides the ability to configure Simscribe. 

To change any of the preferences on the page, click the corresponding check box and then the 
“Save Changes” button. If the change requires a restart, you will be prompted by the page after 
choosing “Save Changes”.

Allow VBS control will open an additional TCP port that is used to accept control commands 
from the VBS Simscribe plugin. When this option is disabled, VBS in-game control of Simscribe 
will not function.

Enable Simscribe DIS replay will prompt Simscribe to replay all recorded traffic through the 
DIS gateway in addition to playing it back locally. For information about configuring the DIS 
gateway for playback or recording, see section 6.3.2.1. Setting up the DIS Gateway for Logging. 
For more information about DIS replay, see section 6.3.3.3. Playback over the DIS Network.

Enable Simscribe Record and Playback for all PDU Types will prompt Simscribe to record 
and play back all DIS PDU types in addition to the standard DIS audio PDU types.
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6.3.3.2. Playback to Local Software and Hardware Clients
Playback of the Simscribe recording occurs automatically via the Voisus Client. This works for 
local or DIS Network playback. The client is set up through the Voisus Server web-based 
interface. See section SECTION 3.0. VOISUS SOFTWARE CLIENT for client setup 
information.

Note that when a replay is in progress the high bit of the DIS application ID is automatically 
flipped. The user DOES NOT need to modify the DIS gateway configuration. This is done to 
avoid duplicate radio identifiers on the network and allows for seamless replay to the client 
application.

Note: Simscribe playback audio does not go out over the DIS gateway. 
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Voisus Client
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Voisus-VBS2 plugin
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6.3.3.3. Playback over the DIS Network
Playback over the DIS Network can be configured on the ‘Preferences’ page. For more 
information, see section 6.3.3.1. Configuring Simscribe Preferences. Choosing to play back over 
the DIS network prompts Simscribe to play back audio, and optionally all PDU types, out of the 
DIS gateway in addition to local clients. This is useful if you want to hear AAR playback on a 
different system or network from where the original recording was made. It is also useful for 
testing DIS settings or playing back a multi-system exercise.

Local DIS
Gateway

Simscribe
Playback
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Log file

Voisus Client
Distribution

Voisus
Network

Voisus Server with Simscribe enabled

Voisus Thin 
Client #1

Serious Game
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Serious Game
Dedicated Server

Software Required
for each setup

Thin Client Thin Client 
Voisus-VBS2 plugin

Thin Client 
Voisus-VBS2 plugin

Simscribe plugin

Thin Client 
Voisus-VBS2 plugin

Client side filtering on
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Network
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Client #2

Voisus
Network

Virtual Simulator /
Live Radio Comms

Voisus Server Telestra Server
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or

Constructive
Simulators

DIS Gateway

6.3.3.4. Voisus Client and Serious Game Communications Filtering
The Voisus Client and serious game plug-in allow a user to filter the playback stream to include 
up to eight simultaneous nets. The net selection(s) available in the client will generally match the 
scenario configuration, however they do not have to match. The net(s) for the client are 
configured in the Voisus Server Comm Plan page. See section 2.4.1. Comm Plans & Roles for 
more information.
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6.3.4. Logging or Recording an Event

Before beginning a new recording, verify that the logging settings are configured correctly. These 
setting will determine what data Simscribe captures. See section 6.3.2. Logger Setup for more 
information.

To start a new recording press the record button. When the recording is in progress you will see a 
“Recording in progress” message appear right above the scroll bar. The left side of the scroll bar 
will show 00:00:00 and the right side will show the current length of the recording. The graph 
shows time on the x-axis and number of PDUs on the y-axis. The time will display the last 20 
seconds worth of PDU information, will scroll in real-time, and will pause if the recording is 
paused. 

After the recording is complete follow the steps below to save the current event. 

1. Pause the recording.

2. Press the ‘Save’ button.

3. Enter the recording name.

4. Select or deselect the optional ‘Append Date and Time’ box.
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5. Press the ‘Save’ button.
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6.3.5. Playback of an Event

Before starting playback of an event, verify that the playback settings are configured correctly. 
These settings will determine what data Simscribe replays and where that data is replayed. See 
section 6.3.3. Playback Setup for more information.

To play back the current event you must first stop the current recording if one is in progress; see 
previous section for details. Then select the event you wish to play back by pressing the load 
button.

Technical Note: If you go to the middle of a radio transmission and begin playback, you may 
miss some audio up to the DIS heartbeat (default value: 5 seconds). This is because you have 
started playback after the DIS active transmitter PDU was broadcast to the clients. The client will 
thus not recognize the radio transmission until:

a. The DIS heartbeat time has elapsed from the previous active transmitter PDU 
transmission and the transmitter broadcasts an additional transmitter active PDU. 

OR

b. The transmitter stops and restarts the transmission.

Once the event has been selected press the load button and you will see the following:
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The name used during the save process of the event will be displayed. In the example above, the 
event was named “event27_11_15_2011_1610”. The initial state of a newly loaded file will 
display “Currently not playing.” When the play button is pressed you will see the playback is in 
progress:
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6.3.6. Managing Bookmarks

Bookmarks can be used to quickly navigate through a recording during playback. All bookmarks 
have a time stamp and a description.

During recording, create new bookmarks with the “Add Bookmark” button. 

• To edit a bookmark, click on the description and enter new text as desired. You can also edit 
the time if needed.

• To delete a bookmark, hover over the description and select the red delete icon that appears.

When the recording is saved all of the current bookmarks will be saved with it.

To use bookmarks during playback, simply click the orange bookmark or hover over the 
bookmark description and select the play icon. Bookmarks can be modified, deleted, or added 
during playback. However, the changes will not be retained when a new file is loaded.
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6.3.7. Managing Logs

Manage the saved Simscribe recordings under the ‘Logs’ tab. The Logs page lists all the saved 
recordings on the Voisus Server. Select one or more of the saved files and use the buttons on the 
right to perform operations. 

• Delete: Deleting a file is permanent. Once a file is deleted from the server there is no way to 
recover it. 

• Rename: Select one file at a time to rename it.

• Download: Select the log(s) to create a compressed archive (TGZ) file which is down-
loaded onto the PC you are using.

• Upload: Select an archived log file to upload to the Voisus Server. 
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6.4. Simcribe for VBS2

ASTi’s Simscribe tool for VBS2 is completely integrated into the game connecting the in-game 
after action review (AAR) controls with Simscribe. Once the plugin is installed, the in-game AAR 
controls will sync with Simscribe controls with no additional effort.

Important: Simscribe VBS2 control is enabled by default on standard Voisus platforms. If the IA 
Maintenance software package is installed, the VBS2 control interface is disabled by default and 
must be enabled to function. See APPENDIX D: INFORMATION ASSURANCE FEATURE 
CONTROL for more information.

6.4.1. Installing the Simscribe Plugin for VBS2 

Simscribe is installed as part of the Voisus plugin for VBS2. You must first download the Voisus 
Client for your Windows operating system. See section SECTION 3.0. VOISUS SOFTWARE 
CLIENT for more information. The client must be running when using the Simscribe VBS2 
plugin.

See section SECTION 4.0. VBS2 PLUGIN for the installation details. To use in-game controls, 
VBS2 must be opened in administrator mode. 

The user can do AAR net selection through VBS2 in-game controls. Alternatively, the user can 
use the standard Voisus Client to filter nets. See section SECTION 3.0. VOISUS SOFTWARE 
CLIENT for more information.
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6.4.2. VBS2 In-Game Simscribe Controls

Recording

The basic operation of Simscribe is exactly like the in-game VBS2 AAR record and playback. 

Open VBS2 and start a mission. To launch Simscribe for the first time press ‘Shift+Alt+H’ to 
open the Simscribe configuration. 

Enter the Voisus Server’s IP address. In the “Simscribe enabled” field, select “On” if you would 
like this station to control the Simscribe recording. 
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Start recording in VBS2 Realtime Editor page.

When recording is stopped the save screen automatically comes up.
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Another save screen will automatically open. Save the file again with the same name. 

If the file is not saved with the same name, the RMS log file must be renamed to the same file 
name without the date and time appendages. 

See Bohemia Interactive Simulation’s VBS2 documentation for AAR details. 
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Playback

Note: To receive Simscribe playback tune your Voisus Client to the nets that you wish to hear. See 
section SECTION 3.0. VOISUS SOFTWARE CLIENT for more information. 

To play back recordings navigate to the VBS2 AAR page. 

The list of recordings available for playback are under ‘Missions’ as shown below. Select the 
mission recording you wish to play back.
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Use the in-game AAR playback controls. 
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SECTION 7.0. RADIO BRIDGE AND REMOTE 
RADIO CONTROL
7.1. Radio Bridge Introduction

Radio Bridge is a digital voice communications system that routes live radio voice traffic between 
multiple sites over local and wide area data networks, providing a wealth of capabilities that:

• Extend live radio communications through the data network. Example: Link aircraft radios 
in Nevada to ground radios in Germany.

• Realize intercommunications between disparate live radio systems. Example: PRC-117 in 
AM mode is bridged to PRC-119 in FM mode.

• Integrate Radio Bridge with other servers to link operators with shared live radio assets, 
conserving live radio usage. Example: Operators at USAF Ops Center and operators at 
Exercise Control intercommunicate with live aircraft and tank radios.

• Integrate voice comms for live-virtual training exercises. Example: Live aircraft in Nevada 
communicates with Special Forces flight simulator.

• Remotely command and control the Radio Bridge over the network. Example: Remote Man-
agement System (RMS) software at Exercise Control is used to configure, monitor and man-
age Radio Bridge.

Radio Bridge integrates live and simulated voice communications from an array of sources into a 
unified network, providing a balance of simplicity and flexibility to facilitate installation and 
management of communications for networked exercises.
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Features of Radio Bridge:

• Flexible and Scalable Architecture: Configure server to meet custom requirements.

• Interoperability: Inter-operates with full fidelity radio simulations.

• Deployable out-of-the-box: Connect, configure, and operate.

• DIS/HLA Compliant: Interoperable with a vast array of simulators, data analysis and data 
logging tools.

• Simple to Install: Modular/click-together, all-Ethernet installation.

• Simple to Run: Even novice users can exploit the capabilities of ASTi’s powerful and intui-
tive software. 

• Robust and Reliable: Industrial hardware, Intel Quad Core CPU, Realtime Linux OS.

Voisus Server
Radio Bridge

RT
RT

RT
RT

ACENet
Network

Remote Management
and Configuration

Customer Furnished
Live Radios

Radio Bridge Example
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7.1.1. Live Radio Installation

The Radio Bridge has been tested and is officially supported for several Radio Transceivers (RT). 
It may be possible to support other radio types by configuring the advanced Radio Bridge settings. 
ASTi recommends that advanced configuration be made with ASTi support. See section 7.1.4. 
Advanced Radio Bridge Configuration for more information.

The Radio Bridge has official support for the following RTs:    

DESCRIPTION MODEL

SINCGARS, SIP RT-1523C/D

SINCGARS, ASIP RT-1523E/F

Falcon II PRC-117 

Multiband Inter/Intra Team Radio 
(MBITR)

JTRS Enhanced MBITR (JEM)

PRC-148 

LOS Transceiver URC-200

IMPORTANT: RTs should always be in the OFF or STANDBY state when not in use. Following 
this rule will prevent unintentional keying of RTs. Keying RTs for excessive periods of time may 
damage the RTs.

The following RT installation criteria MUST be followed for proper system operation:

1. The Base RTs (these are the RTs that are connected to the ACE-RIU. There is one Base RT 
for each RT net) must have the following panel settings:

SETTING
SINCGARS
RT-1523C/D

SINCGARS
RT-1523E/F

PRC-117 PRC-148 URC-200

Volume Max (Full CW) 9 9 4 Max (Full CW)

Mic Gain Whisper = OFF Whisper = OFF N/A Mic Lvl=High N/A

Squelch ON ON ON ON ON

Mode SC or FH SC or FH SC or FH SC or FH SC or FH

COMSEC PT or CT PT or CT PT or CT PT or CT PT or CT

Other Notes 1, 2

Notes:
1. PRC-148: MODE / Audio Path = TOP AUDIO
2. PRC-148: It’s important that you disconnect the radio from the ASTi ACE-RIU before 
switching Audio Path = TOP AUDIO. “Hot switching” the radio’s audio path may cause 
the ACE-RIU to go offline, requiring system reboot. 

IMPORTANT: Each of the Base RTs must have unique frequency or net settings (either SC 
frequencies or FH nets). If any of the RT frequency / net assignments are not unique, the system 
will not perform properly. 
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2. Set up the Field RTs. Each of the Field RTs comprising a given net must have panel 
settings for: MODE and COMSEC that match the corresponding Base RT for the net.

3. If the MODE-FH or COMSEC-CT settings are selected on any of the RT nets, follow 
proper procedures for loading the FH Data or COMSEC Keys into the Base and Field RTs. 
Refer to the RT manual for fill procedure details.

IMPORTANT: The Base RTs must be installed so that a high fidelity radio link with 
remote RTs is established (ideally) using the LOW transmit power setting on the Base 
RTs. 

4. The Base RTs may be set to MEDIUM transmit power, but the possibility of Radio 
Frequency Interference (RFI) between the Base RT and the ASTi system is increased. If 
system malfunctions occur (such as spurious RT or network transmissions or increased 
audio noise on the nets,) re-establish the Base RT to Remote RT links using LOW power. 

Under no circumstances should any of the Base RTs be set to HIGH transmit power. RFI 
will occur between the RTs and the ASTi system, causing the system to malfunction (spu-
rious transmissions and increased audio noise).

The RT manual states that the planning range for low power, line of sight installations 
using the standard manpack or vehicle antenna is 200 meters to 400 meters.

These planning ranges may be degraded due to environmental factors. 

Use of OE-254 (tower) antennas are highly recommended for increasing ranges, improv-
ing RF link fidelity and greatly reducing the chance of RFI. 

5. The final step in the RT installation procedure is to perform a standard radio check 
between each set of Base and Field RTs as part of the system operational checkout.
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7.1.2. Radio Bridge Configuration

This section describes the Voisus Server Radio Bridge configuration using an example for live 
radio bridging of up to 8 radios.

Follow the steps below to set up the Radio Bridge software configuration in RMS.

Step 1: Comm Plan

1. Open the Comm Plan in RMS.

2. Select the example “RadioBridge8” comm plan that is preconfigured with 8 nets. The 
names, frequencies, waveforms, etc. may be changed to match virtual radio nets that live 
radios will bridge to.
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Step 2: Facility

1. Select a new Facility and rename it. This example uses “RadioBridge8” for the Facility 
name. 

2. Navigate to the “Live Radio Interfaces” in the Facility. 

3. There are 8 interfaces. These are the interfaces to the live radios. Rename them 
appropriately to match the live radios. 

4. The live radios will connect directly to an ACENet device channel. Select the ACENet 
device and audio channel for each radio. Note: Serial port connection is for remote control 
only and is not needed for radio bridging. 
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Step 2a (Optional):

Use the advanced settings to tweak audio characteristics of the radio interface.

• In threshold: the value (in dB) at which Live Radio audio triggers Virtual Radio transmis-
sion.

• In Gain: gain multiplier applied to the live radio audio entering the bridge system; applied 
after the threshold detection.

• Out Gain: gain multiplier applied to the virtual radio audio leaving the bridge system.

• Rx Decay: the decay rate (in seconds) applied for the Virtual Radio Rx Active flag, used to 
prevent spurious Live Radio retransmission.

Step 3: Scenario

In the Scenario the physical radios are mapped to the virtual radio nets.

1. Select “RadioBridge8” for the Scenario.

2. Select the previously configured comm plan and facility. 

3. Under the live radio interfaces you will see the interfaces that were configured in the 
facility.

4. For each live radio, select the virtual radio net to map to. 

5. Save the changes and install the scenario.

Note: You may need to change your Domain and configure your DIS settings if you have not 
already done so. See section 2.2.5. DIS Settings.
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7.1.3. Radio Bridge Status

This section describes the Voisus Radio Bridge status widget. The status widget is visible on the 
Scenario Runtime Status page when a scenario with Radio Bridges has been installed. (See 
section 2.3.7. Runtime Status.)
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7.1.4. Advanced Radio Bridge Configuration

7.1.4.1. How the Radio Bridge Works

Radio Bridge Logic

Live to Virtual

1. The Live Radio audio is digitized and sent through a software Gate. The Gate (or Noise 
Gate) controls the volume of the Live Radio signal by silencing the signal below a certain 
threshold value. This value is chosen such that when the Live Radio is idle the radio audio 
will fall below the threshold, and when it is actively receiving the audio will rise above the 
threshold. This way, the Gate output will only be active when the Live Radio is actively 
receiving.

2. The Gate output audio is then sent to a Virtual Radio, effectively relaying the Live Radio 
audio. When the Live Radio is actively receiving, the Virtual Radio will be actively 
transmitting and relaying the Live Radio audio.

Virtual to Live

1. When the Virtual Radio starts receiving a transmission from another virtual radio it sends 
the receive audio to the Live Radio.

2. Along with the audio, a discrete signal is sent to activate the Live Radio’s PTT. This way, 
the Live Radio starts actively transmitting the audio received by the Virtual Radio.

Transitioning between Live to Virtual and Virtual to Live

Transitions between Transmit states happen after inactivity. For example, if a Live Radio is 
sensed as actively receiving it must cease receiving before it can transmit. Likewise, if a Virtual 
Radio is actively receiving, it must cease receiving before it can transmit.
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7.1.4.2. Custom Radio Bridge Settings Tutorial

This section describes the method for tweaking radio bridge settings (available on the Facility 
page, under the Live Radios tab). Use these settings to connect a radio transceiver (RT) model that 
ASTi has not yet documented support for, or for addressing problematic behavior with officially 
supported RTs.

1. Set up the Live Radio by ensuring proper communications with a Field Radio.

2. Connect the Live Radio to the Radio Bridge system.

3. Adjust the In Threshold value such that it is slightly higher than the sensed level of the 
Live Radio output audio, while it is idle. Monitor the Live Radio output audio on the 
Runtime Status page (see section 2.3.7. Runtime Status) by clicking on the name of the 
Live Radio. This output audio level is displayed as a root mean square value. Note that the 
Gate threshold level operates on the peak levels of the radio, so adjust the threshold with 
ample additional headroom for transients in the audio signal.

4. If done correctly, the idle Live Radio should not trigger the Virtual Radio to transmit. If 
the Runtime Status Radio Bridge widget is showing spurious transmissions, or if a 
connected endpoint (e.g. Voisus Client, HHT Operator, etc.) is receiving spurious 
transmissions, re-adjust the In Threshold so that it is slightly higher (per step 3).

5. Test the Radio Bridge by transmitting from a Field Radio to the Live Radio. A silent 
transmission (i.e. keying the PTT but not speaking) should trigger the Virtual Radio to 
transmit. Monitor the Radio Bridge Runtime Status widget to verify this condition.

6. (Optional) Adjust the In Gain setting to change the Live Radio audio level going to the 
Virtual Radio. Use this if other virtual radios are receiving a signal that is too low or too 
high. This gain is applied after the Gate, so the In Threshold should not have to be 
readjusted after adjusting In Gain.

7. (Optional) Adjust the Out Gain setting to change the Virtual Radio audio level going to 
the Live Radio. Use this if field radios are receiving a signal that is too low or too high.

8. (Optional) Adjust the Rx Decay setting to change the amount of time it takes after a 
Virtual Radio has transmitted before the Live Radio can transmit again. This is necessary 
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to prevent a ‘chatter’ effect. Increase this if Virtual Radios keep retransmitting short 
segments just after actively receiving.
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7.2. Remote Radio Control

ASTi Remote Control is an optional feature of the ASTi Voisus Radio Bridge. Remote Control 
adds the capability to adjust live radio settings over an IP network using ASTi’s Remote 
Management System (RMS) web page. You can also control radios from a tablet computer using 
ASTi’s Tablet Voisus App. (See section 7.2.5. Tablet Voisus App.) 

ASTi's web-based RMS is embedded inside every Voisus Server, so you can manage all ASTi 
hardware (with device auto-discovery) and software resources on the network. The optional 
Remote Control provides users with the ability to remotely control and monitor multiple live 
radios from any browser access point on the network.

Remote Control is compatible with the URC-200 (v2) Radio Set.

URC-200 remote control capabilities include: 

• Preset channel select

• Receive and Transmit Frequency

• Receive and Transmit Modulation mode

• Squelch level 

• Transmit power level

• Text mode

• Store Preset (store current preset to URC-200 memory)

URC-200 monitoring capabilities include:

• Preset selected

• Receive and Transmit Frequency

• Receive and Transmit Modulation mode

• Squelch status 

• Squelch level

• Transmit power level 

• Text mode

• Receive signal strength

• Synthesizer Lock/Unlock status

• Overtemp status

• Software Version information

• Installed options

• Operational mode
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Compatibility

ASTi Remote Control is compatible with:

• ASTi Voisus Radio Bridge, with ACE Software v5.2.6 or later

• ASTi Tablet Voisus App, with ACE Software v5.6.2

• URC-200 Radio Transceiver, PN with Software Version VC 98-P41135F Ver01 Jun 03 1999 
07:49:10
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7.2.1. Software and Hardware Descriptions

Radio Control is comprised of the following components:

Hardware

• ASTi Voisus Server

Description: Processing platform running remote radio control software.

• ACE-RIU (also referred to as RIU)

Description: Remote interface unit for audio input/output. 

• ASTi Serial Data Cable

Part Number: CA-MS3116-D9M

Description: This cable connects the URC-200 J2 (26-pin MIL connector, for serial con-
trol) and the serial data convertor. 

• ACE-RIU to URC-200 Cable

Part Number: CA-D9M-NC6M

Description: This cable connects the URC-200 J4 (6-pin connector, for audio and PTT) 
and RIU Audio/PTT port.

• Modular Data Cable 

Part Number: CA-RJ12-RJ12

Description: This cable connects the Serial Data Convertor to the RIU serial data port. 

• Serial Data Convertor 

Part Number: SDCM-01

Description: This compact module converts serial data protocol from radio RS-232 to RIU 
RS-422 and is powered through the serial data line.

Software

• ASTi Software 

Version Number: 5.2.6 or later

Description: ASTi application software, installed on Voisus Server.

• Remote Management System

Description: Accessed through a web browser to provide management, configuration, and 
system administration. 
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7.2.2. Setup Overview

1. Install the hardware to interface the URC-200 radio’s audio / serial data port to the ACE-
RIU. The hardware includes: adapter cable, serial data convertor and serial data cable.

2. Activate URC-200 radios and fill or preset channel presets.

3. Use a networked PC running a standard web browser to access the RMS web page and 
gain remote control and monitoring of all URC-200s connected to Voisus Radio Bridges.

Advanced Simulation Technology, Inc.
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Top Level Layout of Voisus Radio Bridge with URC-200 Remote Control Option
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7.2.3. Installation

1. Ensure the software (v5.2.6 or greater) is properly installed and running on the Voisus 
Server.

2. Attach URC-200 live radios to ACE-RIUs. Refer to the figure below. 

a. Attach X-Mode 26-pin MIL connector (1 below) to radio with the ASTi Serial 
Data cable (6).

b. Connect 6-pin connector (2 below) with the ACE-RIU to URC-200 cable (7 
below) to the radio.

c. Attach ‘Audio’ DB9 connector (3 below) to an ACE-RIU audio channel. Refer to 
live radio interface list, as defined in the Facility > Live Radios section of RMS.

d. Attach ASTi Serial Data Cable (6 below) to Serial Data Convertor (5 below).

e. Attach ASTi Serial Data Convertor (6 below) to Modular Data Cable (4 
below).

f. Attach Modular Data Cable (4 below) to ACE-RIU serial port. Refer to live radio 
interface list, as defined in the Facility > Live Radios section of RMS.

URC-200
J2 Jack

ASTi RIU
Channel Jack 
(Audio & PTT)

ASTi RIU
Serial Data Jack
(Remote Control)

DB9 Connector

ACE-RIU to URC-200 Cable

Serial Data Convertor2

4

3

5

4

KEY:

Modular Data Cable

3

1

URC-200 J2 Jack

X-Mode 26-pin MIL
1

2

5URC-200 J4 Jack

6-pin Connector for audio/PTT

URC-200
J4 Jack

ASTi Serial Data Cable6

6

7

7

Detail, Voisus Radio Bridge with URC-200 Remote Control Option
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7.2.4. Operation

Note: Using the URC-200 with an attached remote control unit will put the radio into a ‘remote 
control’ mode and the keypad will be locked. This constraint is inherent to the URC-200. To 
release the lock the user can disable the remote control from the RMS interface. (See “Disable 
Remote Control” below.)

Check live radio status

1. Ensure all live radios are connected and turned ON.

2. Access the RMS system on the Voisus Server. You can use a web browser on any machine 
that is connected to the same network as the Voisus Server.

3. Click the ‘Radio Remote Control’ icon on the Voisus dashboard. 
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4. Access the ‘View Radio’ drop-down selector to choose the live URC-200 transceiver you 
wish to control. Refer to the live radio interface list, as defined in the Facilities > Live 
Radios section of RMS, to identify the Radio Handle to look for in the drop-down list. 
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5. The ‘Radio Status’ page displays radio status items in a tabular format. The radio status 
should stream to the browser, so that changes will be displayed without having to refresh 
the page (this feature is subject to browser compatibility). See the figure below. Refer to 
“Radio Status” below for more information on each item seen on this page.
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Control live radios

On the Radio Status page, click the “Change Radio Settings” button. See the figure below. 

The Radio Settings page will guide the user through the process of changing settings.
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Disable Remote Control

To disable the remote control data link between a live radio and ACE-RIU, click the ‘Turn if OFF’ 
button at the top of page. See the figure below. 

Disabling the remote control data link also releases the live radio from ‘remote control’ mode so 
that its keypad will become functional again.

If the remote control data link is currently off, the only option on the Radio Settings page will be 
to turn it back on by clicking the ‘Turn it ON’ button. This will enter the live radio into remote 
control mode and effectively lock the keypad. See the figure below.
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Switch Preset

This method of control will allow the user to switch the preset and load the settings from the new 
preset. Any temporary changes made to the current preset will not be saved before switching to 
the new one. The user may re-load the current preset by submitting the preset number for the 
preset the radio is currently using. The user may optionally adjust the squelch level, as this is not 
a setting associated with a preset.
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Modify Presets

This method of control will allow the user to change the parameters associated with the current 
preset. Changing these parameters will not overwrite the current preset in the radio’s memory. 
Instead, the changes will be temporary until the preset is explicitly stored or the preset is 
switched.

Preset settings can be made in a ‘coupled’ (see the figure below) or ‘decoupled’ manner – that is, 
the user can adjust Rx and Tx Frequency and/or Rx and Tx Modulation mode simultaneously or 
separately. The user will select a radio button to specify his preference.

The user may optionally adjust the squelch level, but this is not necessarily a setting associated 
with a preset.
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Send Settings to Radio

Once all changes have been made, click the ‘Send Settings to Radio’ button to submit the 
commands. If a parameter value is deemed invalid, the page will refresh with a list of items to 
amend before trying the request again.

Immediately after submitting a change to the live radio’s settings, the user will be returned to the 
Radio Status page. It might take a few seconds before all of the requested settings are made on the 
radio. The user should monitor the status closely to ensure the changes were made.

Notice the ‘Last Access’ string that is now present in the Radio Status page. This will detail the 
time of the last modification to the radio’s setting and who made it (IP address and username). See 
the figure below. 
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Storing presets: If the user has modified a preset he should now have the option to store the 
preset while on the Radio Status page. Once available, the user can click the ‘Store Preset?’ button 
to commit the preset settings currently being displayed to the radio’s memory

Radio Status

Interface Name: The ACE-RIU device name.

Interface Channel: The ACE-RIU device channel.

Radio Interface Status: The overall health of the live radio interface. The health can be in three 
states:

• Critical (red x): If none of the status items can be retrieved from the radio.

• Semi-critical (yellow question mark [?]): If some of the status items cannot be retrieved 
from the radio or the remote control function has been disabled. 

• Okay (green check-mark): Normal operation
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Radio Type: The model of the live radio.

Status: Detailed status information of the live radio interface, some of the messages the user 
might see here are:

• Remote Control Off: Signifies that the serial messaging is disabled for the interface.

• Err: Bad device name / chan: An invalid ACE-RIU device or channel has been specified.

• Err: check mask / log: A control query might be failing consistently. A log is available to 
view if it is enabled within the ACE Studio development tool.

• Okay: Normal operation

Overtemp: Live radio overtemp status

• Critical (red x): The live radio is in an overtemp state

• Semi-critical (yellow question mark [?]): The overtemp status cannot be retrieved from the 
live radio.

• Okay (green check-mark): The live radio temperature is Okay.

Synth Lock: Live radio synthesizer lock state

• Critical (red x): The synthesizer is unlocked

• Semi-critical (yellow question mark [?]): The synthesizer lock status cannot be retrieved 
from the live radio.

• Okay (green check-mark): The synthesizer is locked.

Preset: Live radio’s currently selected preset. Valid presets are 0-9.

Frequency: Live radio receive frequency. Refer to the radio’s operator manual for operational 
ranges.

Tx Frequency: Live radio transmit frequency. Refer to the radio’s operator manual for 
operational ranges.

Squelch Level: Live radio’s squelch level. Valid range is 0-10.

Power Level: Live radio power level. Valid states are LO, MED, and HI. Refer to the radio’s 
operator manual for operational considerations.

Text Mode: Live radio text mode. Valid states are PT (plain text) and CT (cipher text).

Modulation Mode: Live radio receive modulation mode. Valid states are AM and FM. Refer to 
the radio’s operator manual for operational considerations.

Tx Modulation Mode: Live radio transmit modulation mode. Valid states are AM and FM. Refer 
to the radio’s operator manual for operational considerations.

Operation Mode: Live radio operating mode. Valid states are RECEIVE, TRANSMIT, and 
BEACON. 

Rx Signal Strength: Live radio receive signal strength. Valid range is 0-10.
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Squelch Status: Live radio squelch status. Valid states are ‘Transceiver Squelched’ and 
‘Transceiver Squelch Broken’.

Option: Live radio installed options. Valid options are:

• None: No options installed.

• 30_90: The EBN-30 option is installed.

• 420: The EBN-400 option is installed.

• 30_90 & 420: Both EBN-30 and EBN-400 options are installed.

Software Version: Live radio software version. Refer to the radio’s operator manual for more 
information on the format of this string.
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7.2.5. Tablet Voisus App

The Tablet Voisus App has remote radio control capability. First, follow the instructions in section 
7.2.3. Installation and section 7.2.4. Operation to set up your radio for remote control. Then you 
will need to enable radio control in RMS.

Enable Radio Control in RMS

In RMS, navigate to the Comm Plan page and open the Roles tab. Select the role(s) that should 
have radio control enabled and click the Enable Radio Control checkbox.
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Remote Radio Control on the Tablet Voisus App

Install the Tablet Voisus App on your device as described in section 3.2. Client Software 
Installation. Connect the Tablet Voisus App to the server and a role as described in section 3.5. 
Tablet Voisus App.

Once you have connected to the server and a radio-control-enabled role, a Remote button will be 
available on the main screen. Tap it to access remote radio control.
194 Copyright © 2013 Advanced Simulation Technology inc.



ASTi Voisus Server Operator Manual (Ver. 1, Rev. L)
The Remote screen displays the radio(s) available for remote control as well as a warning if other 
radios are offline. 

The Manual option allows you to manually edit the frequency, modulation, and power level.

The Presets option allows you to choose a preset that has been configured in RMS (see “Modify 
Presets” in section 7.2.4. Operation for more information.)
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Manual

On the Manual page, enter the desired frequency and change modulation and power if desired. 
When you’re done, tap “Set Radio Now”.

You will return to the Remote screen and the changes will take a few seconds to go into effect. 
The changes will appear on the Remote screen once they are active.
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Presets

The Presets page allows you to choose a preset that has been configured in RMS (see “Modify 
Presets” in section 7.2.4. Operation for more information.)

Once the preset is set, the Remote page will reflect the active preset number.
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7.2.6. Troubleshooting / FAQ

Note: The RMS Remote Control user interface will provide helpful suggestions when errors 
occur. The user should heed these suggestions as a first step to troubleshooting.

Why are some status items being displayed as ‘Unavailable’?

If the remote control software cannot retrieve the state of a particular status item from the live 
radio its value will be reported as ‘Unavailable’. Such failures can occur for several reasons. The 
user should ensure that the radio’s software is compatible, specifically with regards to its serial 
protocol. The user should also ensure the cabling is installed correctly on the system.
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The ‘Radio Settings’ form permitted me to modify some settings on the radio, but the 
settings don’t seem to be taking affect.

The ‘Radio Settings’ form will attempt to thoroughly validate the user input by checking for 
syntax errors and live radio operational constraints. In some cases, the settings will seem to be 
valid but still fail. This is most likely due to radio software incompatibility. The user should verify 
that their intended settings will work if they attempt to input them manually, using the keypad on 
the URC-200 and without the ASTi Remote Control connected.

As an example, using an older URC-200 with software from 1995, the user can attempt to set the 
Frequency to 399.995 MHz, which is valid by the URC-200 v2 manual (see further reading). 
However, for this specific radio, the settings will not succeed and an error message will display. In 
this case the user will find that setting the Frequency to something else might work

.
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“No radio bridge interface configured” message is displayed when I attempt to access the 
‘Radio Remote Control’ page.

Remote radio control interfaces need to be configured using the Facility interface. The installed 
Scenario should contain a Facility with Remote Radio Interfaces before the interfaces become 
available for control.

This message can also be displayed during a Scenario installation, in which case the user should 
wait for all the interfaces to populate onto the web page.
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Why is remote control ‘paused’ while the live radio is transmitting? 

When the software detects that the live radio is actively transmitting over the air it will pause the 
serial data messaging between the ACE-RIU and the URC-200. This is done to ensure that no 
serial data noise bleeds into the live radio’s transmit audio. The user should be aware that the 
information on the ‘Radio Status’ page is considered ‘stale’ once this happens, since no more 
commands are being sent to the radio.

Periodically the software will do a check on the radio’s transmit status, to determine if it is once 
again safe to resume the serial messaging.
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7.2.7. Further Reading

• URC-200 (v2) Operation and Limited Maintenance Manual 

General Dynamics Document No: 99-P42304K, Revision: September 2009

• URC-200 (v2) Operation and Maintenance Manual 

General Dynamics Document No. 68-P36745M_REV.
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SECTION 8.0. APPLICATION EXAMPLES
Voisus Server comes with a number of example resources (comm plans, facilities, and scenarios) 
to help familiarize users with its software capabilities and to serve as a starting point from which 
users can begin to configure their own comms environment. Successful use of these examples 
relies upon properly configured network settings.

The examples are:

• Basic_Example: Accommodates only software-based Voisus Clients and will be automati-
cally loaded following system cold start.

• Army_Example: Sample ground force communications structure.

• EmergencyMgmt_Example: Non-military emergency and first responder example.

• HWPanel_Example: For use with ASTi hardware-based interfaces such as hand-held ter-
minals (HHTs) or simulated PRC-117 or SINCGARS radio panels.

• Intercom_Example: Basic organizational structure.

• Maritime_Example: Naval ship to shore communications environment; our most complex 
example.

• Office_Example: Small office comms system.

• RadioBridge4 and RadioBridge8: For connecting 4 or 8 live radios to the IP network.

• TOC_Example: Sample tactical operations center.

• SeriousGame_Example: Demonstrates use of in-game, software-based operators and 
“shared” radios when virtual players use vehicle radios.

Note: If you wish to maintain these examples in their original state, use Voisus Server’s “Save 
As...” capability to create working copies that can be changed without consequence.
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8.1. Basic Example

This section describes how to set up the preconfigured comm plan, facility, and scenario for 
Voisus operators using software-based clients. The basic example provides radio and intercom 
nets for Voisus clients.

Note: After installing the scenario, the clients must connect to the server over the network. See 
section SECTION 3.0. VOISUS SOFTWARE CLIENT and section SECTION 5.0. VOISUS 
HARDWARE CLIENT for more information.

Step 1: Comm Plan
On the Comm Plan page, select the ‘Basic_Example’ comm plan.

 

Step 2: Scenario
On the Scenario page, select the ‘Basic_Example’ and then select the same example for 
the Comm Plan and Facility. Save the changes and click ‘Install Scenario’. 

 

You can now connect a client to the server and talk over the example radio and intercom 
nets. 
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8.2. Hardware Panel Example

This section describes the preconfigured comm plan, facility, and scenario setup for Voisus 
operators using hardware devices. This example is provided to assist the user through a basic 
software setup process. The example includes an optional observer position.

Note: The hardware devices must be connected properly over the network.

Step 1: Comm Plan
On the Comm Plan page, open ‘HWPanel_Example’. This comm plan is preconfigured 
with nets and roles. 

Select the ‘Roles’ tab to view the preconfigured roles. There is one for each hardware 
example, HHT, PRC-117, and SINGARS. 
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Step 2: Facility
On the Facility page, select ‘HWPanel_Example.’

For HHTs: 

The HHT_1 position is a position with an HHT and a headset. Select the ACENet device 
that the HHT is connected to by double-clicking ‘Off’ and selecting the device. You may 
also need to change the audio channel and port depending on how the device is connected.
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The HHT_2 position is a position with an HHT, headset, and a microphone or speaker for 
an observer. Select the ACENet device for the HHT and the observer. You may also need 
to change the audio channel and port depending on how the device is connected.

 

For PRC-117 panels:

The PRC117_1 position is a position with a simulated PRC-117 radio panel. Modify the 
panel’s IP address by double-clicking on the example address and editing it. Note: Refer to 
the ASTi Simulated PRC-117 Panel Operator Guide for Voisus Server (DOC-VS-
PRC117-OG) for details on setup and obtaining the IP address. 

Select the ACENet device that the PRC-117 panel is connected to by double-clicking 
‘Off’ and selecting the device. You may also need to change the audio channel depending 
on how the device is connected.

The PRC117_2 position is a position with a simulated PRC-117 radio panel and an 
observer with a microphone or speaker. Modify the panel’s IP address by double-clicking 
the example address and editing it. Select the ACENet device for the panel and observer. 
You may also need to change the audio channel depending on how the device is 
connected.
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For SINCGARS panels:

The SINCGARS_1 position has a simulated SINCGARS radio panel. Select the ACENet 
device that the SINCGARS panel is connected to by double-clicking ‘Off’ and selecting 
the device. You may also need to change the audio channel and serial port depending on 
how the device is connected.

The SINCARS_2 position has a simulated SINCGARS radio panel and an observer with a 
microphone or speaker. Select the ACENet device that the panel and observer is connected 
to by double-clicking ‘Off’ and selecting a device. You may also need to change the audio 
channel depending on how the device is connected.
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After making changes to your facility, click ‘Save Changes’. 

Step 3: Scenario
Select the ‘Scenario’ tab at the top menu bar. Select the ‘HWPanel_Example’ scenario.

Save the changes and install the scenario. 

You should now be able to transmit and receive over your hardware panels.
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8.3. Radio Bridge Examples

See section 7.1.2. Radio Bridge Configuration to set up the basic radio bridge examples for 4 or 8 
live radios. 
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APPENDIX A: SAFETY AND HANDLING
This section must be read completely and understood before using the Voisus Server. If you are 
unsure of any information presented please contact ASTi.

The following safety precautions must be observed when performing any operation and 
maintenance tasks associated with the ASTi Voisus Server. These safety precautions are necessary 
to prevent injury to personnel and damage to equipment.

Warning: Potentially fatal voltages are present in the Voisus Server. Before removing or replacing 
any component, ensure that ALL electrical supplies have been turned off and electrical power 
cords disconnected from the platform.

The following disclaimer is provided regarding use of the Voisus Server. The disclaimer applies to 
all parties using the system in any situation or configuration. This disclaimer should be read and 
understood completely before using the system.

Disclaimer: The Voisus Server is a sound production device. The user, by the act of installing and 
using the Voisus Server and any associated equipment such as external amplifiers, headsets, 
speakers, etc., warrants and represents that he/she is aware that excessive audio levels can cause 
permanent hearing impairment and that he/she assumes full responsibility for configuring all 
equipment including hardware and software to achieve safe operating sound pressure levels under 
all conditions.

Equipment Handling: All platform circuit boards and modules are sensitive to electrostatic 
discharge (ESD). To avoid damage to system equipment, proper ESD procedures should be 
followed when handling all equipment. Ensure that all work is performed at a properly grounded 
ESD work station. In addition, all personnel handling equipment should be properly grounded.

When transporting or shipping individual modules, equipment should be fully enclosed in an anti-
static bag. ASTi is not responsible for equipment damage due to improper handling.
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APPENDIX B: WARRANTY AND CUSTOMER 
SUPPORT

B.1. Warranty

ASTi provides a one year limited warranty on all ASTi equipment covering all parts and labor.

In the case of equipment upgrades, warranty applies to original date of shipment of individual 
components.

Other commercial equipment purchased or provided such as monitors, amplifiers, speakers, fiber 
optic links, etc. are also covered under the one year warranty unless otherwise stated.

The warranty does not cover improper equipment handling or improperly packaged returns.

Extended warranties are available. Contact ASTi for details at (703) 471-2104.

B.2. Repairs and Returns 

If it becomes necessary to return equipment to ASTi, please observe the following instructions:

Obtain an RMA number through ASTi’s website: http://www.asti-usa.com/support/

When packaging the equipment in question, make sure it is well protected. The device should be 
properly enclosed in an antistatic bag to prevent possible ESD damage. Failure to properly 
package the equipment during shipping could void the warranty.

Do not include accessory pieces such as rack mount kits, power supplies or software. Only send 
items that do not work.

The shipping label must include the RMA number.

Include a description of the problem, point of contact, phone number, return address and unit 
serial number(s). Failure to include this information could extensively delay the return of the 
equipment.

Evaluation of equipment is performed free of charge. No work will be done without prior 
customer approval. Customer is responsible for shipping charges to ASTi for warranty and non-
warranty repairs.

If an RMA number is not used within thirty (30) days of issuing date, the request data and number 
issued will be closed and designated as unused.

Any items received from customers without RMA numbers or appropriate contact information 
included with shipment will not be tested. After sixty (60) days, ASTi reserves the right to scrap 
all hardware received in this condition.

If the equipment is not under warranty a Purchase Order will be required to cover the cost of any 
repairs. ASTi will provide a quote for all non-warranty repair items.

Equipment will be shipped back using Federal Express, unless otherwise directed. If the repair is 
non-warranty then shipping charges will be billed.
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International customers must include the correct product value on all shipping documents. 
Contact ASTi for proper harmonized tariff codes. The customer is responsible for all duties, taxes 
and fees incurred in shipment of the equipment.
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APPENDIX C: USB ADAPTERS AND HEADSETS
Voisus Clients are compatible with the following USB adapters and headsets. All of the listed 
USB adapters provide built-in sidetone. Sidetone is a critical feature that provides the client 
operator with an audible indication that they are actively transmitting.

Note: Additional headsets may function with Voisus Server but are not necessarily recommended. 
Contact ASTi for more information.

USB Adapters

ASTi Part Number Manufacturer Stereo Built-In PTT Compatible Headsets

USB-RADIUS-010 ASTi Yes Yes Specific Telex (see list)

USB-P-DA40 Plantronics No No All Plantronics H-Series 
(see list*)

USB-P-SHS2355 Plantronics No Yes All Plantronics H-Series 
(see list*)

Headsets

ASTi Part Number Manufacturer
Stereo**

Mono
Ear Cups

HS-TX-PH-44R5 Telex Stereo Dual, light weight

HS-TX-HR-2R5 Telex Stereo Dual, noise isolation, 
medium weight

HS-P-HW251 Plantronics Mono Single, light weight

HS-P-HW261 Plantronics Mono Dual, light weight

HS-P-SHR2083-01 Plantronics Mono Dual, noise isolation, 
medium weight

USB Adapter + Headset Combined

ASTi Part Number Manufacturer
Stereo**

Mono
Sidetone Ear Cups

HS-LG-G35 Logitech Stereo Yes Dual, medium weight

Speakerphones

ASTi Part Number Manufacturer Features

USB-P-P420 Plantronics Mic mute and volume controls, active echo cancella-
tion, and auxiliary headphone jack

* Plantronics sales literature states that Plantronics USB adapters are compatible with all 
Plantronics H-Series headsets. ASTi has tested and validated Voisus Clients using the listed 
Plantronics headsets. 
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** Stereo headsets are recommended for use with Voisus-VBS2 plugin. 

Note: Stereo headset and USB adapter are required for stereo sound. 

Plantronics® is a registered trademark of Plantronics, Inc. 

TelexTM is a trademark of Telex Communications, Inc. 
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APPENDIX D: INFORMATION ASSURANCE 
FEATURE CONTROL
ASTi’s Information Assurance (IA) Maintenance package provides the ability to control the use 
of certain Voisus software features. These features within Voisus Server may require the use of 
additional UDP or TCP ports, hence there is a mechanism for an administrator to enable or disable 
them as required for your facility. Changing the feature settings of a platform with IA 
requirements will affect the ports, protocols, and services (PPS) profile of the platform. Consult 
with your IA Security Officer/IA Manager to see if this impacts your IA requirements and/or any 
DIACAP ATO specific requirements.

Voisus controlled features include:

• Debug websocket

• Hookbox

• Multiserver

• Network credits

• PRC-117

• PRC-119

• Radio Monitor Auto tune (for Voisus Clients)

• Realtime

• Simscribe for VBS2

• Voisus Construct

• Chat

• Cloud

• Simscribe DIS Network Replay
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D.1. Feature Descriptions

Debug Websocket (feature name: debugwebsocket)

The debug websocket supports two RMS pages within Voisus Server. The first page is the 
Diagnostics Display (DD), which is used to gather system information for the purposes of 
debugging problems. This is currently for ASTi internal use only. The second function of debug 
websockets is to provide a graphical scope view of radio audio. The Voisus Server Radio Monitor 
application displays the audio from the radio transmission in the scope view. When disabled 
neither Diagnostics Display or the scope will function within the Voisus Server RMS pages.

Hookbox (feature name: hookbox)

Hookbox provides support for websockets and uses long polling as a fallback. Hookbox is used 
for certain RMS pages that are data intensive (i.e. high bandwidth) and hence have been 
optimized for use with websockets. However websockets are not supported by all browsers, hence 
a fallback to long-polling is supported by hookbox. When this feature is disabled certain RMS 
pages will not function correctly. Currently this includes Radio Monitor, Monitor > Performance, 
Monitor > Discovery, and Monitor > ACENet. This list is subject to change based on the release 
version.

Multiserver (feature name: multiserver)

The Voisus multi-server feature is used to simplify configuration for programs with large numbers 
of operators and servers. Multiple servers are organized in a master-slave relationship, this pushes 
the master server configuration to all of the slaves. See section 2.5. Multi-Server Configuration in 
this document for more details. When this feature is disabled a Voisus Server platform will not 
support either the master or slave capabilities required for multi-server operation.

Network Credits (feature name: networkcredits)

Network credits provides shared system licensing for large programs. This feature is designed for 
future use and is currently disabled by default. Contact ASTi for additional information.

PRC-117 (feature name: prc117f)

This feature provides support for ASTi’s simulated PRC-117 radio panel. The PRC-117 radio 
panel provides a realistic panel user interface that works in conjunction with ASTi’s radio 
communications software running on the Voisus Server.  When disabled the PRC-117 radio panel 
will not function.
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PRC-119 (feature name: prc119)

ASTi’s simulated PRC-119 radio panel. The PRC-119 radio panel provides a realistic panel user 
interface that works in conjunction with ASTi’s radio communications software running on the 
Voisus Server. When disabled the PRC-119 radio panel will not function.

Radio Monitor AutoTune (feature name: radiomonautotune)

For Voisus Clients, auto radio tuning enables operators to instantly establish voice 
communications with any simulated radio on the network, simply by clicking on a realtime list of 
“who’s online.” See “Auto Radio Tuning” in section 3.3. Desktop Client for more information. 
When disabled, Auto Radio Tuning will not function and the radio list will not be populated.

Realtime (feature name: realtime)

The realtime environment is currently required for correct Voisus Server operation. This feature is 
designed for future use and is currently enabled by default. Contact ASTi for additional 
information.

Simscribe control via VBS2 (feature name: simscribevbs)

ASTi’s Simscribe tool for VBS2 is completely integrated in the game connecting the in-game 
after action review (AAR) controls with Simscribe. Once the plugin is installed, the in-game AAR 
controls will sync with Simscribe controls with no additional effort. See section 6.4. Simcribe for 
VBS2 for more details. When disabled, VBS2 in-game control of Simscribe will not function.

Voisus Construct (feature name: milcadre)

This feature is designed for future use and is currently disabled by default. Contact ASTi for 
additional information.

Chat

This feature is designed for future use and is currently disabled by default. Contact ASTi for 
additional details.

Cloud

This feature is designed for future use and is currently disabled by default. Contact ASTi for 
additional information.
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Simscribe DIS Replay

ASTi’s Simscribe tool for AAR can replay logged DIS PDUs locally or over a DIS LAN/WAN. 
When disabled, all PDUs will be played through the DIS gateway only. When enabled all DIS 
PDUs will be replayed onto the network interface and port defined in the DIS gateway in RMS.

D.2. Default Feature Controls

The table below lists the default settings for Voisus software with and without the IA package 
installed.

Features
Voisus Software 

Default
IA Software Default

debugwebsocket ON OFF

hookbox ON ON

multiserver ON OFF

networkcredits OFF OFF

prc117 ON OFF

prc119 ON OFF

radiomonautotune ON ON

realtime ON ON

simscribevbs ON OFF

Voisus Construct OFF OFF

Chat OFF OFF

Cloud OFF OFF

Simscribe DIS Network 
Replay

OFF OFF

Note 1: The feature list and default settings may vary based on software version.

Note 2: Changing the feature settings of a platform with IA requirements will affect the ports, 
protocols, and services (PPS) profile of the platform. Consult with your Information Assurance 
Security Officer (IASO)/Information Assurance Manager (IAM) and/or DIACAP ATO 
documentation for details.
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D.3. Changing Feature Controls 

ASTi’s Simscribe tool for use with VBS2 can be controlled via the Remote Management System 
(RMS). To change the default for Simscribe navigate to Manage > Preferences. Then select to 
allow control and save the changes. A reboot is required for the changes to take effect. 

The remaining features are controlled via the Voisus Server system command line. A connected 
monitor and keyboard are required to log into the Voisus system command line. The user should 
have basic working Linux knowledge before proceeding. All commands must be run as root.

To view the current features and settings type:

acecontrol feature_get

This command will show the feature list and their current settings.

To enable a feature type:

acecontrol feature_enable xyz

where xyz is the feature name. For example to enable PRC-117 type:

acecontrol feature_enable prc117 

Reboot the system for the enabled feature to take effect.

To disable a feature type:

acecontrol feature_disable xyz

where xyz is the feature name. For example to disable Radio Mon Auto tune type:

acecontrol feauture_disable radiomonautotune 

Reboot the system for the disabled feature to take effect.

Important: Backup and Restore Information

If changes are made to the default feature controls these changes are included as part of the 
system backup. For example, if a system’s multiserver default is OFF and the feature is enabled 
and the system is backed up, the backup will include the multiserver as turned ON. 

When performing a restore it is important to note that the feature controls have order 
dependencies. When the order is A, B, and C, as shown below and a backup file (C) is restored on 
top of the IA software (B) then the backup file takes precedence over IA.

A) Cold start defaults - set via ASTi Voisus Server Cold Start Procedure (DOC-05-VS-CS-1)

B) IA defaults - set via ASTi IA Software Installation Procedure (DOC-01-IA-IP-1)

C) Backup file settings - set via RMS backup/restore (for details see section 2.2.3. Back Up 
and Restore the System)

When the order is C and then B as shown above and the IA software (B) is installed after the 
backup file (C) then the IA settings take precedence over the backup file. 
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